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About the Backup Exec for NetWare Windows Client
Backup Exec is a high performance data management solution for Novell networks.    With the Backup 
Exec Windows client, you can submit backup and restore operations from your workstation to a server 
containing the Job Manager and a tape drive (backup server).      

Restoring files is quick and easy, because Backup Exec's extensive disk-based catalog keeps track of all 
of the files that you have backed up.

Related Topics:
General
Elements
Interaction
Administrator Options



General
Backup Exec is a "client - server" based backup system that allows Administrators and Users to back up 
servers and workstations network-wide. This configuration has many advantages:

· Operations are performed right at the server, reducing network traffic and processing times.

· Workstations need only to be attached (not logged in) to servers to be backed up. This helps 
ensure network security.

· The Administrator controls the tape drive right from the server, ensuring efficient, centralized 
operations.



Elements
Backup Exec for NetWare consists of the following elements:

· Job Manager - The module which resides on the fileserver where the tape hardware is connected 
(backup server).    The Job Manager is comprised of two NLMs: the Job Server, which is Backup 
Exec's main processing engine; the Job Console, which is the user interface for the Job Server.

· Client Software - The module users and administrators use to submit jobs to the Job Manager.    
Client modules are available for DOS, Windows, and NetWare platforms.    

· Agents - The Backup Exec agent software allows workstations running it to be backed up by 
devices running the client software.    Agent software for DOS and Windows workstations is 
included with Backup Exec for NetWare.    OS/2, UNIX and Macintosh agent software is also 
included with Backup Exec - Enterprise Edition.



Interaction
The following illustrates how the Backup Modules work together to provide complete, convenient backup 
and restore functionality for the network:

· Backup and restore jobs are submitted to the Backup Server from workstations running the 
Backup Exec client software (DOS, Windows, or NLM server client). 

· Workstations running the Backup Agent software or SMS TSAs and attached to the Backup 
Server can have jobs submitted for them by an administrator or user running a DOS, Windows or 
NetWare client.

· The Job Manager NLM running on the Backup Server runs jobs when they are to be processed. 

· Once an operation has been completed, the results (Job History) for the job and the catalog 
information can be viewed in the client software by the originator of the job or the supervisor.



Administrator Options
The following options are available to Administrators only:

· File Grooming

· Ability to view job results and catalogs for ALL users (users only have access to results and 
catalogs for devices they have submitted jobs for)

· Tape overwrite functions

· Ability to delete catalog information for any user

· Tape rotation



Features and Benefits
Backup - Schedule Backup jobs to run at any time to back up any or all available devices on the network.

Selection Files - Select devices, directories or files that you want to routinely back up and save them as 
"selection files", which can be scheduled to run as often as you wish.

Restore - Retrieve data that you have backed up or restore data backed up from another server or 
workstation.    Backup Exec also includes features which allow you to quickly find the data you want to 
restore.

Device-based Catalogs - Backup Exec's catalog keeps a record of the files you have backed up.    This 
makes it easy to find data you want to restore.

Job Schedule and Job History - The Job Schedule allows you to see where your job is in the backup 
queue.    The Job History contains information about jobs already processed by the Backup Exec Job 
Manager.

Windows Flexibility - The Backup Exec Windows Client gives you all of the functionality you expect from
a Windows application.    Features range from multitasking to customizing window sizes and locations to 
suit your own Windows workstation preferences.

Device-Based Catalogs - Backup Exec's catalog keeps a record of the files you have backed up.    The 
contents of the catalogs are displayed in graphical form in the Restore window.    They are arranged so 
that you can find files based upon where they were originally located (something you probably already 
know) instead of the order in which they were placed on tape.    This makes it much easier to find the data
that you want to restore.

Job Manager Monitoring - The client's Job Manager Monitoring feature allows you to monitor the 
ongoing status of your jobs that are running on the server.



Workstation Requirements
Your Windows workstation should have the following minimum requirements to effectively run Backup 
Exec:

· A 386 microprocessor (or above)

· Windows v.3.1 or greater running in Enhanced mode

· Mouse or other pointing device



Recommendations
We suggest that, before running the Windows Client, you refer to your Windows documentation for the 
recommended settings for files and buffers in the CONFIG.SYS file, and edit your own file to reflect these 
settings.

We also suggest that you run the DOS program SHARE.EXE (provided with Windows) in conjunction with
the Windows client.    This program will enable Job Manager to determine if a file is in use when 
attempting to back it up or restore it, and respond appropriately.    If you do not run SHARE.EXE, the Job 
Manager may back up files in use inadvertently.



Carrying Out Operations
These instructions are written for users performing the operations using a mouse.    If you are familiar with
keyboard commands, you can perform the same operations using the keyboard.    To choose a menu 
option using the keyboard, press <Alt> or <F10> to access the menu bar, then press <Alt> plus the 
underlined letter within the desired command name.    



Windows Client and Agent Installation
Be sure to set up the appropriate network services (through Windows Setup) and login to the Backup 
Server from the workstation before beginning the installation process.    Refer to your Windows 
documentation for help.

Backup Exec includes an installation program that loads the Windows client software from the file server 
onto your system. The installation process also sets up the Backup Exec program group in Windows. 

Related Topics:
Where the Software is Installed
Setting Up the Software



Where the Software is Installed
The installation program creates the following subdirectories on your hard drive:

· \BKUPEXEC contains WIN_WS\WIN31

· \BKUPEXEC\WIN_WS\WIN31 contains Data files for Backup Exec

You will be prompted for a name for each directory.    You may accept the default names or choose your 
own names.



Setting Up the Software
To install the Backup Exec Windows Client and Agent software on your workstation:

1. Start Windows.

2. From within the Windows Program Manager, click File.

3. Click Run.

4. In the Command Line box, enter the drive letter mapped to the Backup Server's SYS: volume, 
followed by \bkupexec\win_ws\win31\setup (assuming that the Backup Exec software is 
installed in the default location; see your administrator to determine the exact location). For 
example:

F:\bkupexec\win_ws\win31\setup
5. Press <Enter>.

6. Select and click the type of installation you desire: Full, Client, or Agent.    If this is the first time 
Backup Exec has been installed on your system select Full.    The Backup Exec installation 
program will copy the appropriate files to your workstation. 

7. Follow the on-screen instructions.

The installation program automatically creates a Windows program group for the Backup Exec modules.   
The Windows Client and Agent items added to the group include:

· Backup Exec - Windows Client

· Agent Publisher - Windows Agent Publisher

· Readme.txt - Additional information about the Windows Client



Configuring the Agent with the Agent Publisher
The Agent Publisher is used to configure the Windows workstation as a Backup Exec Agent. This 
determines how your workstation's drive will be seen by other workstations running the Backup Exec 
client.    During setup, the Agent Publisher dialog box will automatically appear if you have chosen either 
the Full or Agent setup options.

Before a Windows agent workstation can be backed up or restored, it must first be made available to the 
various client front-ends on the network.    This is known as publishing the agent.    To publish an agent, 
the following drivers must be loaded on the workstation agent:

· Novell modules IPX.COM and NETX.COM (must be loaded first)

· Backup Exec modules DOS_SPX.EXE and DOS_AGNT.EXE

Note: You may use the ODI and/or VLM drivers instead of IPX.COM and NETX.COM.    Just make sure 
that the network drivers are loaded before the Backup Exec modules.

To automate the process of loading these drivers, edit and add these commands to your AUTOEXEC.BAT
file.

Once these drivers have been loaded and the Agent Publisher dialog box has been configured, the 
workstation is considered published.    It is now available to be backed up (or restored to) from the various
clients on the network, including other Windows clients.

Backing up (or restoring to) the Windows agent does not require the workstation to be logged into the 
backup server; however, it must be published.

Related Topics:
The Agent Publisher Dialog Box
Modifying the AUTOEXEC.BAT File
Rebooting the Workstation



The Agent Publisher Dialog Box

Fields
Each Agent Publisher field is explained below.

Workstation Name

The Workstation Name identifies the published workstation agent to the network, and is used when 
making job selections from Backup Exec Clients.    This field is required.

Password

This optional password will prevent unauthorized users from gaining access to the agent workstation 
when using other Backup Exec clients.

Path

Regarded as objects of the agent workstation, Agent Publisher path statements designate specific data 
that can be backed up from the workstation hard drive.

Alias

An alias is a name that users from other workstations (running Backup Exec client software) use to 
identify the published paths of your agent workstation.

Access Password

This optional password prevents unauthorized users from backing up or restoring specific Agent 
Publisher-specified paths.

Publish

The Publish boxes work in conjunction with the Path boxes.    By activating a Publish box with a mouse 
click (an 'X' appears), the published path allows the workstation to be seen on the network by the Backup 
Exec's Client software.      Other workstation clients, no matter what the platform, can submit jobs from 
these published workstation agents to the Job Manager.

Backup Only

The Backup Only field indicates the operational status of the preceding path fields.    Activating this option 
allows only backup of the specified object; restoring data to the object is not possible.    Activate this field if
data is NOT to be restored to the associated path statement.

Browse

The browse button is used to easily configure other paths.    If you are unfamiliar with using Window's 
Browse feature, see your Windows 3.1 User's Guide.

Save

After configuring each field in the Agent Publisher dialog box, click Save to save the configuration 
information.    This information is saved to a default filename called DOS_AGNT.PUB, located in your 
workstation's \bkupexec\WIN_WS directory.

Exit

Exit allows you to exit from the Agent Publisher program.

If, during the initial Windows client/agent installation process, you chose to install only the Client module, 



you will need to install the Agent module before the Agent Publisher dialog box will appear.



Modifying the AUTOEXEC.BAT File
When the installation is almost complete, you will have the opportunity to add the following lines to your 
AUTOEXEC.BAT file (if you have chosen to install the Agent software):

C:\bkupexec\win_ws\dos_spx.exe

C:\bkupexec\win_ws\dos_agnt.exe

DOS_SPX.EXE and DOS_AGNT.EXE are Terminate-and-Stay- Resident (TSR) programs.    Backup Exec
uses these programs to access your workstation.    Both files must be loaded before any agent Backup 
Exec operation is attempted.    Including these lines in the AUTOEXEC.BAT file ensures that these two 
programs are loaded each time the workstation is powered up.

After the installation completes, Setup helps you edit the AUTOEXEC.BAT file by automatically copying 
the DOS_SPX and DOS_AGNT lines to the Windows Clipboard.    It then opens your AUTOEXEC.BAT file
using Notepad.    By using Notepad's Paste feature, you can place the agent statements in the 
AUTOEXEC.BAT file wherever you want.    

NOTE:    Be sure to save and close the Notepad file before proceeding.

If the last line of the AUTOEXEC.BAT file loads Windows, then two lines above the last line must be 
placed in the AUTOEXEC.BAT file prior to the line that loads Windows.    Also, make sure Novell's 
IPX.COM and NETX.COM are loaded prior to the DOS_SPX.EXE and DOS_AGNT.EXE files.

Following is an example of the commands you should place in the AUTOEXEC.BAT file:

ipx.com

netx.com

c:\bkupexec\win_ws\dos_spx.exe

c:\bkupexec\win_ws\dos_agnt.exe

NOTE: You may use the ODI and/or VLM drivers instead of IPX.COM and NETX.COM respectively.    Just
make sure that the network drivers are loaded before the Backup Exec modules.

Once you have closed the Notepad file containing the AUTOEXEC.BAT file, the setup process displays 
another Notepad file containing a Readme.txt file.    

NOTE:    We recommend that you read this file carefully; it contains information that became available 
after the manual was published.

If you find that the Windows Client does not recognize agents published on the network, check your 
system to see if a TSR called TBMI2.COM is being loaded into memory.    This is a Novell module 
provided with older systems running in non-enhanced mode.    If it is present, we recommend that you 
delete TBMI2.COM from the system.



Rebooting the Workstation
After completing the installation, reboot the workstation. This workstation should now be available for 
backup through any of Backup Exec's client programs. 

To configure other Windows workstations as Backup Exec agents and/or as clients, simply login to the 
backup server from the desired workstation and re-run the setup procedure.



Starting the Windows Client
To run the Backup Exec Windows Client software:

1. Double-click on the Backup Exec icon within the Backup Exec program group.

2. When the NetWare client is loaded, it scans all SMS devices and published agents on the 
network.    The Scanning for Network Agents window lists each device as it is encountered.    
Should the startup process halt at a particular device, that device may be the cause of a network 
problem that requires attention.

3. If you encounter a problem with an SMS device (SMDR), you can create a SMDRINCL.DAT file 
that will allow you to only include certain devices. 

The software also identifies the current Backup Server in the status bar at the bottom of the 
window.

4. Once the user interface is initialized, Backup Exec displays the Windows Client desktop.    When 
the Ready message is displayed in the Status Bar, you can begin your first operation.



Screen Components
Menu Bar

After starting the Backup Exec Windows Client, a menu bar is displayed across the top of your screen.    

You use the Menu Bar to access Windows Client functions.    To display a menu, click on the menu name, 
or press <F10> to move your cursor to the Menu Bar and then press <Alt> plus the underlined letter in the
name of the menu you want to display.    

To display the File menu, press <F10>, then <Alt + F>.

The Selection Bar

The Selection Bar is displayed across the top of the screen under the Menu Bar.    The Selection Bar 
contains buttons that you click on to quickly access Backup Exec functions.    

The Administrator view of the Selection Bar includes a button used to access File Grooming functions.

You can choose to not display the Selection Bar by clicking on the View menu, then clicking on Selection 
Bar to remove the check mark that selects it.

Icons

When you initially start the Windows Client, there are icons at the bottom of your screen for Backup and 
Restore operations.    If you are an Administrator, an additional Tapes icon also appears at the bottom of 
your screen. Whether you have icons at the bottom of the screen or open windows when you 
subsequently start the Windows Client is determined by their status at the time you exit the Windows 
Client. 

Status Bar

Messages about the status of Backup Exec are displayed in the Status Bar.    You can choose not to 
display the Status Bar by clicking on the View menu, then clicking on Status Bar to remove the check 
mark that selects it. 

Exiting the Software

To exit the Backup Exec Windows Client, select Exit from the File Menu or click on the Exit button on the 
Selection Bar.



Rights
Backup Exec abides by the rights assigned to you by the system administrator.    If you do not have 
sufficient rights to a directory on the server (that is, you are not an administrator), you will not be able to 
back up or restore files in that directory.    



About Backup
Backing up your entire workstation as illustrated in the following section is the easiest and most 
comprehensive backup method.    You can also select directories and/or files if you wish. 

Related Topics:
Running a Simple Backup
Performing a Simple Backup - Administrators
Selecting Directories or Files for Backup



Running a Simple Backup
Additional Administrator options for this procedure follow these steps.

To create a backup job for your Windows workstation:

1. Double click the Backup icon in your Windows Client window.    This opens the Backup Sources 
window.

2. To open the Backup Sources window using the keyboard, press 
<Alt + W> to display the Window Menu.    Then, use the down arrow key to highlight Backup and 
press <Enter>.

This window lists published agents on your network.    These are workstations that are available to
be backed up.    An agent may be either a NetWare agent or a Backup Exec agent.

If you are signed on as a Backup Exec user, you will see all published NetWare agents in the 
Backup Sources window, and your own published Backup Exec agent workstation.    To see other 
users' Backup Exec agents, you must be signed on as an administrator.

If a new agent has been published since the application was started, it will not show up in the 
Backup Sources Window until the window is refreshed (using the F5 function key).    If the 
NetWare Agent you are looking for does not show up in the window, it is possible that it is not in 
the SMDRINCL.DAT file.

3. On the left side of each agent icon displayed in the Backup Sources window is a small check box.
When the mouse pointer is over the check box, the pointer changes to a pen.    Using this pen, 
click the check box to select your workstation.    The X indicates the workstation has been 
selected.    (To make selections using the keyboard, use the cursor movement keys to highlight 
the workstation, then press <Spacebar> to check the selection.)    If the checkbox is empty, the 
item is not selected.    If the checkbox is checked with a black mark, the item is fully selected.    If 
the checkbox is marked with a gray mark, then it is partially selected.    For example, if you select 
a single file within a directory, the directory will be marked with a gray box.

4. If you select the wrong workstation, clicking on the X (or pressing <Spacebar again> erases it and
removes the workstation from the selection.    You can also select the workstation by highlighting 
the workstation name and clicking on the Check button (in the Selection Bar); to de-select the 
workstation, click on the Uncheck button.    You can use the Uncheck All selection (from the Select
menu) to cancel all your choices and start over.

5. If the password database is not activated, Backup Exec will prompt you for a password for each 
device that you select.    You will need to enter passwords for those devices that are password 
protected.    Press <Enter> or click OK to ignore the password prompt for those devices that are 
not password protected.

6. When your selections are complete, click the Backup button or select Submit Backup from the 
Job Menu.    This opens the Submit Backup Job window.

The Submit Backup Job window has the backup defaults selected.    You can override the settings
(making changes here does not affect your default settings).    You can also provide a name for 
the job and a description for the backup set(s).    See the related topic, Submit Backup Job 
Window Components.

7. If you want to change the frequency for the job, click the Frequency button to the right of the 



window.    This opens the Job Frequency Information window.    See the related topic, Job 
Frequency Information Window Components, for options

8. Click OK to accept your frequency changes and return to the Submit Backup Job window.

9. Click OK when you are ready to submit the backup job.    Click Cancel if you do not want to 
proceed.

10. Backup Exec displays a window confirming that your job has been successfully submitted to the 
Backup Server.

Related Topics:
Submit Backup Job Window Components
Job Frequency Information Window
Advanced Job Options Window
Login Window



Submit Backup Job Window Components
This dialog box enables you to submit a backup job to the Job Manager.

This window is displayed when the Backups Sources window is active and you choose Submit Backup 
from the Job menu, or click the Backup button located on the Selection Bar.

JOB INFORMATION

Job Name

Enter a name that will differentiate this job from others in your job history records. Maximum length for the
job name is 24 characters.

Target Partition

The first available partition (that allows the user, and the type of operation being performed) is selected as
the default partition.    Press <Enter> in the Target Partition field to display other partitions on which the job
can be processed.    Move the selection arrows next to the desired partition and press <Enter>.

New Tape Name (Administrators only)

Enter a name that identifies a tape.    If this is an overwrite job, this name will be used as the new name 
for the tape.    If this is an append job, and the tape in the drive is blank when this job is run, this value will 
be used as the name of the tape.    If the job is appended to a tape that already has data on it, this name 
will not be assigned to the tape.

New Tape Password (Administrators only)

Enter a password to prevent unauthorized access to the tape.    If this is an overwrite job, the tape 
password will be used as the new password for the tape.    If this is an append job, and the tape in the 
drive is blank when this job is run, this value will be used as the tape password.    If the job is appended to
a tape that already has data on it, this password will not be used.

Backup Type

For a first time backup, leave Normal marked.    There are four backup types:

· Normal (default)- backs up all selected files and changes the files' status to "backed up".

· Incremental - only backs up selected files that were modified or created since the last Normal 
backup.    Selecting Incremental will also change the files' status to "backed up".

· Differential - only backs up selected files that were modified or created since the last Normal 
backup.    Selecting Differential does not affect a file's backup status.

· Copy - backs up all selected files, but does not change their backup status.    This manual fully 
describes the different forms of backup.

Verify After Backup

Selecting this option has Backup Exec check to make sure the files you wrote to the tape can be read 
once a backup has been completed.    The default value for this field is set in the Backup Options dialog.

Eject tape after job (Admin only)

Select this option to have Backup Exec automatically eject the tape in the drive once the job is completed.
This function can be used in single or multiple drive configurations, but has no affect on loaders.

Current Frequency



Indicates how often the job is to be run.    To change this value, click the Frequency button at the right of 
the window.

OPERATION (Admin Only)

Append

Causes backed-up files to be added to those already on tape.    Non-administrative jobs are always 
submitted in Append Mode.

Overwrite

Causes backed-up files to be written over those already on tape.    Be careful; OVERWRITE can 
potentially destroy another job's data.

Execution Date

Date this job is next scheduled to process.    This date relates to the value in the CURRENT 
FREQUENCY field.    If the CURRENT FREQUENCY field indicates that the job is scheduled to run once 
only or to repeat every X days, the EXECUTION DATE field can contain any valid date.    If CURRENT 
FREQUENCY indicates that the job is to repeat every X weeks on X, or repeat each month on X day, the 
date in this field must fall within those parameters.    If you select a date that does not fall within the 
parameters, Backup Exec substitutes the next date that does fall within the CURRENT FREQUENCY 
criteria.    For example, suppose a job is scheduled to occur on the 30th of each month but you select the 
18th for the backup.    When you leave the EXECUTION DATE field, Backup Exec displays a message 
informing you that this is an invalid date and resets the date to the 30th.

Execution Time

Enter the time the job is to run.    You can change this value by clicking on the up and down arrows to the 
right of the value.

BACKUP SET INFORMATION

Device Name

Name of the workstation you are backing up.    This is the name you selected from the Backup Sources 
window.

Set Name

Name identifying the data you are backing up.

Set Description

Describes the data you are backing up.

FREQUENCY

Click on this button to change the schedule for the job.



Job Frequency Information Window
This dialog box enables you to change the schedule for a job.

This window is displayed when you click on the FREQUENCY button when editing or submitting a job.

Execute Only Once

Select this option if you want the job to process one time only.    When it is complete, it will not be 
rescheduled.    If the job fails to execute, Backup Exec places it on hold.    If you choose this option, the 
result is a once-only job.

Repeat Every [ ] Days

Select this option if you want the job to repeat after a given interval, beginning with the specified 
execution date.    Enter the number of days to elapse between jobs in the space provided.    For example, 
you can choose to run a job every 14 days.    If you choose this option, the result is a continual job.

Repeat Every [ ] Weeks On

Select this option if you want the job to repeat at a given weekly interval on the day(s) of the week 
specified.    For example, you can choose to run a job every two weeks on Friday.    Note that this 
schedule may change the execution date.    If so, the date is set to the next date that falls within the date 
range.    If you choose this option, the result is a continual job.

Repeat Each Month On

Select this option if you want the job to repeat on a specified day each month.    For example, you can 
choose to run a job on the 15th of every month.    You can also enter "L" to schedule a job for the last day 
of each month.    Note that this schedule may change the execution date.    If so, the date is set to the next
month whose Nth day has not yet been passed.    If you choose this option, the result is a continual job.



Advanced Job Options Window
This dialog box enables you to set the advanced job options for a job.    Note that the contents of this 
dialog will vary depending on whether the job is being submitted or edited.    The job type also affects the 
contents of the dialog.

Scan devices to estimate backup size - Select this option to have Backup Exec estimate the number of 
bytes to be backed up when the backup operation begins.    This option may cause the backup to take a 
little longer, but it allows you to monitor the progress of the operation (by percentage complete).    This 
option is not available for restore jobs.

Submit job on hold - Select this option to submit the job with a hold status.    This is useful when you 
want to submit a job, but you are not ready for the job to run.    Selecting this option while editing a job 
puts it on hold.

Console command before job (Administrator only) - This option executes a console command on the 
backup server before the job starts to run.    You can also specify a delay time to occur between the time 
the command is executed and the start of the job.    This option is only available during job submission 
and cannot be changed through job editing.

Console command after job (Administrator only)- This option executes a console command on the 
backup server after the job runs.    You can also specify a delay time to occur between the time the 
command is executed and the start of the next job.        This option is only available during job submission 
and cannot be changed through job editing.



Login Window
This dialog box is displayed when Backup Exec requires a username or password in order to access data
on the network.    The name of the device that is being accessed is in the window's title bar.

User name - Enter the name of the user that is to be used to access the device.    If the device being 
accessed does not require user names, the user name field will not be shown.

Password - Enter the password to be used to access the device.



Performing a Simple Backup - Administrators
The steps that Administrators follow in performing a simple backup are the same as those for users.    
However, Administrators are presented with additional options and information.

The Administrator view of the Backup Sources window includes all published Backup Exec agents as well
as all published NetWare agents.

Related Topics:
Submit Backup Job Window Components - Administrator View



Submit Backup Job Window Components - Administrator View
The    Administrator view of the Submit Backup Job window includes the following fields:

New Tape Name - Enter a name that identifies a tape.    If this is an overwrite job, this name will be used 
as the new name for the tape.    If this is an append job, and the tape in the drive is blank when this job is 
run, this value will be used as the name of the tape.    If the job is appended to a tape that already has 
data on it, this name will not be assigned to the tape.

New Tape Password - Enter a password to prevent unauthorized access to the tape.    If this is an 
overwrite job, the tape password will be used as the new tape password for the tape.    If this is an append
job, and the tape in the drive is blank when this job is run, this value will be used as the tape password.    
If the job is appended to a tape that already has data on it, this password will not be used.

Target Partition - The target partition tells Backup Exec where you want this job to be performed.    If you 
have multiple backup devices or a loader attached to the current backup server, you may be able to 
perform this job on any one of several partitions.    Note that partitions can be restricted to specific users 
or job types.    So, if a partition which you know exists does not show up in the Target Partition drop down 
list, it is probably because the partition either does not support the current job type or you do not have 
access to the partition.    If you do not care which partition is used, you can use the "First Available" option
which will cause the job to be run on the first available partition that supports the job.

Operation

Defines the way the backed-up information will be placed on the tape.

· Append - Data will be added after that already existing on the tape

· Overwrite - Data will be written over that already existing on the tape

Be careful in making your Operation selection.    If you choose Overwrite, you can potentially destroy data.
For example, if a user submitted an "append" backup and you follow immediately with an "overwrite" 
backup, you will erase the information that the other user just backed up unless the current tape is 
swapped for another tape between jobs.



Selecting Directories or Files for Backup
There are some instances where you may choose to back up a directory or group of files rather than all of
your hard drive.    For example:

· If you have certain directories or files that contain critical data that needs to be backed up 
frequently.

· When you are backing up files or directories to copy to another workstation.

To back up directories or files:

1. From the Backup Sources window, select the agent at which the directory/file is located and 
double-click on the agent name, or use the cursor movement keys to highlight the agent name 
and press <Enter>.    This expands the tree to show the services contained within the agent 
workstation.    

2. Double-click on a service name to expand the tree further and show the volumes established 
within the service.    

3. Then, double-click on the selected volume name to expand the tree and display the Directory 
Tree window.    Use the Tree Menu in the Menu Bar for quick expansion of the directory tree.

4. Disk directories are displayed on the left side of the Directory Tree window; subdirectories and 
files are displayed on the right side of the Directory Tree window.    Double-click on each 
subdirectory name until the desired file is listed.    Select Split from the View menu to display a 
split bar that you can use to adjust the size of each side.    You can also hide the label bar that 
provides column titles for the Directory Tree window; to do so, choose Label Bar from the View 
menu (ensure that a check mark does not appear beside the Label Bar option if you want to hide 
the column titles).

5. On the left side of each directory and file is a check box.    Click on the check box (or highlight the 
directory or file name and press <Spacebar>) to select the directory or file you want to back up.

If you select a directory, all files contained in that directory are selected.    You may select as many
directories and files as desired for the backup.

6. To include all subdirectories in the directories selected for this backup, click on Select in the Menu
Bar.    If there is a check mark    to the left of Include Subdirectories, all subdirectories (in the 
directories you selected) will be included in the backup. If you do not want to include 
subdirectories click on Include Subdirectories to remove the checkmark.

7. Clicking on Include Subdirectories affects only subsequent selections.    Selections made before 
clicking on Include Subdirectories will not include subdirectories.

8. When your selections are complete, click on the Backup button in the Selection Bar or select 
Submit Backup Job from the Job Menu.

9. This will open the Submit Backup Job window.    You can now proceed to submit the job.



Advanced File Selection - Backup
Advanced file selection enables you to quickly select groups of files to be included in or excluded from 
your Backup and File Grooming operations.

To make your Advanced File Selections, follow these steps:

1. Select the device(s) you want to back up or groom.

2. Click on Select in the Menu Bar and click on Advanced or click on the Advanced File Selection 
button in the Selection Bar.    

This opens the Advanced File Selection - Backup window.    See the related topic, Advanced File 
Selection - Backup Window Components.

3. After making your file selections, click on OK.

4. If you are going to use these selections only for this backup or file grooming operation, you can 
now begin the operation.    If you want to save these selections for future use, click on Select and 
click on Save Selections to create a selection file.

5. You can now continue with the job as with any other backup job.

Related Topics:
Advanced File Selection - Backup Window Components



Advanced File Selection - Backup Window Components
The following choices are available in the Advanced File Selection - Backup window:

Include or Exclude Files

Select whether to Include or Exclude all files that meet your file specifications.    The default is Include.    
Click on Exclude if you want to exclude files from the operation.

File Specification

Specify where Backup Exec should look, and what to look for, when selecting files that will be included in 
or excluded from your Backup or File Grooming operation.

Device

Select the device that contains the files you want to include or exclude.    The field contains the name of 
the device you chose through the Backup Sources window.    Click on the down arrow located to the right 
of the device field to scroll to other available devices.

Path

Enter any available directory or subdirectory on the device selected.    Enter the full path to the 
subdirectory (do not include the device identifier).    For example, if you have selected drive C:, and the 
data you want to back up is in the MEMOS subdirectory of the DOCS directory, your full path would be C:\
DOCS\MEMOS.

File

Specify any files to be included or excluded.    Wildcard characters are permitted.    The asterisk (*) in a file
name or extension is a wildcard character that represents all characters occupying any remaining position
in the file name or extension.    The question mark (?), the wildcard for a single character, is also 
supported.

For example, to include all files with the .EXE extension, type the following:

*.EXE
The default for File is *.*, which means every file name with every extension will be selected.

Include Subdirectories

Choose Include Subdirectories to include all subdirectories contained within all directories that are part of 
your selections.

If the operation is beginning at the root level of a disk (e.g., drive C:), all directories and subdirectories on 
that disk will be included.    If you entered a specific path (directory), all of the subdirectories contained 
within that directory will be included.

Selection Criteria

Specifies the files to be included in the backup operation:

· All Files - Choosing All Files will include all files in the backup or file grooming operation.    All 
Files is the default.

· Files Dated Within This Range - Choosing Files dated within this range will include or exclude 
all files that were changed or created within the specified range of dates.    Specify a beginning 
(From) and an ending (To) date.



· Files changed within the last [] days.    Choosing this option creates a selection that includes 
files changed within the specified number of days when the job is run.    So, if you submit a 
repeating job, each time the job is run, the Job Manager will back up the files modified within the 
previous specified number of days.    Note that this option is not available as an Exclude.

For a file to be included in or excluded from the operation, it must match all of the criteria specified.    



Selection Files
Selection files are files, created by you or supplied with Backup Exec software, that contain information 
about the specific devices, directories, and/or files that you want to back up.    Once created, selection 
files are available for re-use as necessary, saving you time in making backup selections.

Selection Types

Backup

These are selections used for backup and file grooming jobs.    They are stored in the Backup Exec 
subdirectory on the workstation.

Tape Rotation (Administrator only)

These are selections used for tape rotation jobs.    They are stored in the tape rotation path on the current 
backup server.

Selection Files

Displays a list of existing selections.    Click on the selections to be used for the operation.    For 
administrators, the selection files listed will differ for the two backup types.

Related Topics:
Saving Selection Files
Using Selection Files
Deleting Selection Files
Viewing Selection Files



Saving Selection Files
Follow these steps to save a series of selections in a selection file:

1. Select the devices, directories, and/or files you want to back up.

2. Click on Select in the Menu Bar.

3. Click on Save Selections.    This opens the Save Selection File window.

4. Enter a name for the new selection file.

The name used for the selection file must conform to the DOS file naming rules (maximum of 
eight characters).    The file extension .BKS will automatically be added to the name you enter.    If 
a selection file already exists with the name you enter, the program asks if you want to replace 
that file.

5. Click on Save to save the new selection file.



Using Selection Files
This window displays a list of selection files which can be used in a tape rotation (administrators only), 
backup, or file grooming.    When you clear the selections, Backup Exec loads the new selections you 
have chosen.    If you choose not to clear the selections, Backup Exec adds the new selections to the 
current selections for this operation.

For administrators only, the particular selection type chosen will affect the list of selection files that are 
available.

Note:    If Backup Exec cannot locate a device included in the selections (e.g., if a device is turned off), an
error message is displayed and selections for those devices are not made.

Follow these steps to use a selection file:

1. Click on Select in the Menu Bar.

2. Click on Use Selections.    This opens the Use Selections window.

3. Click on the selection file you want to use, then click on Use, or just double-click on the file you 
want to use.    The selections in the Backup Sources window are updated to reflect those 
described in the selection file you chose.

4. Click the Backup button or choose Submit Backup from the Job Menu.    This will open the Submit
Backup Job window.    The Backup window has the backup defaults selected.    At this point, you 
can override the settings (making changes here does not affect your default settings).    You can 
also provide a label for the backup set(s).

5. Click OK when you are ready to begin the backup.    The program displays a window informing 
you that the job has been successfully submitted to the backup server.



Deleting Selection Files
Follow these steps to delete a selection file you are no longer using:

1. Click on Select in the Menu Bar.

2. Click on Delete Selections.    This opens the Delete Selection File window which lists each of the 
selection files available to you.

3. Click on the selection file you want to delete, then click on the Delete button, or just double-click 
on the file you want to delete.    The program displays a confirmation dialog.

4. Click Yes to delete the selection file, or click No to cancel the delete operation and keep the 
selection file.



Viewing Selection Files
Follow these steps to view the contents of a selection file:

1. Click on Select in the Menu Bar.

2. Click on View Selections.    This opens the View Selection File window.

3. Click on the selection file you want to look at, then click on View, or just double-click on the file 
you want to view.    This opens a window displaying the selections contained in the selection file.    
The title bar of the window tells you the date and time at which the selection file was saved.

4. Use the scroll bar to look through the selection file and view all of its contents.

5. When you finish viewing the selection file, click on the control box to close the window.

6. You can print the contents of a selection file at any time by choosing Print from the File Menu 
while the Selection File window is active.



Editing a Backup Job
Backup Exec enables you to change information for a scheduled backup operation.    If you are an 
Administrator, you can edit any job in the queue.    If you are not an administrator, you can edit only those 
jobs which you have submitted.    Whether you are a user or an Administrator, you can edit only those jobs
which are in Ready or Hold status; you cannot edit active jobs.    

Follow these steps to edit a backup job:

1. Display the Job Schedule window by either selecting View Schedule from the Job menu, or by 
clicking on the Job Schedule button on the Selection Bar.

2. Highlight the job you want to change by clicking on it.

3. Click on the Edit button at the bottom of the window.    This opens the Edit Backup Job window.

4. The Edit Backup Job windowEdit Backup Job Window ComponentsEdit Backup Job Window 
Components enables you to change the information set up for the job.    To edit the job frequency, 
click on the Frequency button to the right of the window.

5. When your changes are complete, click on OK to save them and close the window.

Related Topics:
Editing a Backup Job - Administrators



Editing a Backup Job - Administrators
The steps that Administrators follow in editing a backup job are the same as those for users.    However, 
the Edit Backup Job window presents additional fields for the Administrator to edit.



Performing a File Grooming Operation (Admin)
With Backup Exec's File Grooming feature, you can free valuable server disk space by migrating files that
have not been accessed within a certain period of time to tape.    The files that you select are backed up, 
the backup is verified, and the files are removed from the hard disk.

Backup Exec performs file grooming operations only on volumes which support last accessed date for 
files (i.e., NetWare servers, OS/2 HPFS volumes, UNIX NFS volumes, etc.).

When a file grooming job is submitted, the files you specified for the operation are backed up and verified.
After the data is verified successfully, the files are automatically deleted on the device from which they 
originated.    

When using the file grooming feature, make sure the Preserve last accessed date... option in the Job 
Manager is marked.    Otherwise the date for each NetWare file will be changed each time a file is backed 
up.    

Related Topics:
File Grooming Process
File Grooming Notes



File Grooming Process
To set up a File Grooming job:

1. In the Backup Sources window, select the device(s) containing the data you want to groom.    
Expand the Directory Tree window as necessary to reach the appropriate level of information.

2. When your selections are complete, click on the File Grooming button in the Selection Bar or 
select Submit File Grooming from the Job Menu.

This opens the Submit File Grooming Job window.    (If any of your selections are on devices that 
do not support file grooming, you will be notified now.)    The Submit File Grooming Job window 
includes your backup defaults.    

3. You may override these settings for this particular operation.    See the related topic, Submit File 
Grooming Job Window Components.

4. Be careful in making your Operation selection.    If you choose Overwrite, you can potentially 
destroy data.    For example, if a user submitted an "append" backup and you follow immediately 
with an "overwrite" backup, you will erase the information that the other user just backed up 
unless the tape is swapped between jobs.

5. After completing the Submit File Grooming Job window, click on OK to submit the file grooming 
job.

6. The file grooming operation will automatically perform a verify operation after the data is backed 
up.    If the verification of data fails, the operation will stop and the program will notify you of the 
failure.    Your files will not be groomed from the disk.    If you receive a verification failure, identify 
the file(s) that failed to verify, correct the problem, and start the file grooming operation again.

7. You can save your file grooming job selections as selections files, just as you can for any backup 
job.

Related Topics:
Submit File Grooming Job Window Components



Submit File Grooming Job Window Components
This dialog box enables you to submit a file grooming job to the backup server.    File grooming 
capabilities are available to Administrators only.

This window is displayed when the Backup Sources window is active and you choose Submit File 
Grooming from the Job menu, or click on the File Grooming button on the Selection Bar.

Job Name

Enter a name that will differentiate this job from others in your job history records.

New Tape Name - Enter a name that identifies a tape.    If this is an overwrite job, this name will be used 
as the new name for the tape.    If this is an append job, and the tape in the drive is blank when this job is 
run, this value will be used as the name of the tape.    If the job is appended to a tape that already has 
data on it, this name will not be assigned to the tape.

New Tape Password - Enter a password to prevent unauthorized access to the tape.    If this is an 
overwrite job, the tape password will be used as the new tape password for the tape.    If this is an append
job, and the tape in the drive is blank when this job is run, this value will be used as the tape password.    
If the job is appended to a tape that already has data on it, this password will not be used.

Target Partition - The target partition tells Backup Exec where you want this job to be performed.    If you 
have multiple backup devices or a loader attached to the current backup server, you may be able to 
perform this job on any one of several partitions.    Note that partitions can be restricted to specific users 
or job types.    So, if a partition which you know exists does not show up in the Target Partition drop down 
list, it is probably because the partition either does not support the current job type or you do not have 
access to the partition.    If you do not care which partition is used, you can use the "First Available" option
which will cause the job to be run on the first available partition that supports the job.

Backup Type

For file grooming operations, Copy is the only valid backup method.

Eject tape after job (Admin only)

Select this option to have Backup Exec automatically eject the tape in the drive once the job is completed.
This function can be used in single or multiple drive configurations, but has no affect on loaders.

Groom files not accessed in [ ] days

Specifies the number of days that a file should be dormant before being backed up and removed from 
disk.    The program will groom only the files that have not been read or created during this many days.

Current Frequency

Indicates how often the job is to be run.    To change this value, click on the Frequency button at the right 
of the window.

Operation

Determines how the groomed file will be added to the backup tape:

· Append - Add files at the end of the tape, leaving existing files intact

· Overwrite - Replace files on the tape with the groomed files

Execution Date

Date the job is scheduled to process.    You can change this value by clicking on the up and down arrows 



to the right of the value.

Execution Time

Time the job is scheduled to process.    You can change this value by clicking on the up and down arrows 
to the right of the value.

Device Name

Name of the workstation you are grooming.    This is the name you selected from the Backup Sources 
window.

Set Name

Name identifying the data you are grooming.

Set Description

Describes the data you are grooming.

Frequency

Click on this button to change the schedule for the job.



File Grooming Notes
Tapes used for file grooming jobs can only be overwritten by administrators.    To prevent the tapes 
containing file grooming jobs from being erased accidentally,    write-protect the tapes and store them in a 
safe place.

If you select individual files within a directory, only the files within that directory will be groomed.    The 
directory will not be deleted once the operation has been completed unless the software is configured to 
remove empty directories.    Root directories are never deleted.

If you enter 0 in the Groom files not accessed in x days field in the Job Information window, all selections 
will be groomed.



General
Backup Exec's built-in tape rotation module automates scheduling backups for network administrators.    
Once the Tape Rotation (TR) feature is set up, all you have to do is designate devices to be included in 
the tape rotation job, prepare tapes for the job, and insert the appropriate tapes in the drive when Backup 
Exec asks for them.



Setting Up a Tape Rotation Job
Backup Exec allows you to set up or esablish tape rotation jobs.

Related Topics:
To set up a tape rotation job in the Windows Client:



To set up a tape rotation job in the Windows Client:
1. Double click on the Backup icon in your Windows Client window.

This opens the Backup Sources window.

NOTE:    To open the Backup Sources window using the keyboard, press <Alt + W> to display the
Window Menu.    Then, use the down arrow key to highlight Backup and press <Enter>.

2. Click on the check box to select the device(s) you want to include in the tape rotation job.

3. When your selections are complete, open the Job menu and select Submit Tape Rotation.    This 
opens the Save Tape Rotation Selection File window.

4. Enter a script name for the tape rotation job and press <Enter>.

5. Fill out the fields for the Schedule Tape Rotation Job window.    Descriptions for each field are as 
follows:

Job Name

The name you wish to assign for the tape rotation job.    Tape rotation job names can be up to 24 
characters long.    

NOTE: To make tape rotation jobs easier to recognize in the Job Schedule, Backup Exec 
automatically applies a "TR_" prefix to the script name.      If you do not want your job name to 
include this prefix, use <Backspace> to remove it.

Day of week to perform full backups

The day of the week for the weekly full backup to occur.    

To change the day of the week, click the down button, select the day of the week you want the 
backup to take place and click OK.

Execution Date

The date the first tape rotation job (baseline backup) will run.

Time

The time of day the tape rotation job should be executed everyday.

Target Partition

In the two fields provided, you can select loader (or multiple tape drive) partitions for Full and non-
Full operations generated for this Tape Rotation job.    Only partitions which have been configured 
to allow Tape Rotation jobs are listed in each target partition selection window.    If only one 
partition allows Tape Rotation jobs, that partition will appear in both fields.

Backup Set Information

Enter a backup set name and description for each volume included in the tape rotation job.

6. Click OK when your selections are complete.      Another window displays.    

7. Once you have read the information, click OK to exit the window.

8. If there are tape rotation tasks to be performed, the Tape Rotation Task window will appear.    This
window includes functions that need to be performed before a tape rotation job can take place 
(e.g., prepare tapes, etc.).    



9. A full (baseline) backup will be performed on the device(s) you included in the tape rotation job.    
This baseline backup will be regarded as the beginning of the tape rotation job and differential 
backups will be performed each day until the next full backup is to take place.    



Tape Rotation Save Selection File window (Admin)
This window saves current tape rotation selections to a file.    These tape rotation selections can then be 
used at a later time by selecting the file in the Use Selections Dialog.

Related Topics:
To save tape rotation selections:



To save tape rotation selections:
1. Choose Save Selections from the Select menu.    The dialog box displays a selection box, 

containing the name under which to save the selections, and a list box, containing a list of all 
selections saved thus far.    

2. You can choose one of the names in the list, or enter a new name in the Save Selection box.    At 
this point, Backup Exec will request any additional passwords required for access to selected 
devices.    

3. Press the SAVE button to save your selections; you can retrieve them later through the "Use 
Selections" option.

4. If you attempt to SAVE new selections into a selection file currently used by a tape rotation job, 
you will be asked if you wish to update your tape rotation job with the new information.    

If you choose YES, your selections will replace the selections currently assigned to the tape 
rotation job.    If you choose NO, you must select a different name to save the scripts under.    

NOTE:    You can only overwrite a selection file used by a tape rotation job if you also overwrite 
the selections associated with the job.

Save Selection

Specifies the file name to save current tape rotation selections.    The name can be eight 
characters or less, and cannot contain spaces.

Selection Files

Displays a list of previously saved tape rotation selections.



Viewing and Editing a Tape Rotation Job
Once a tape rotation job has been set up, you can view and/or change its attributes.

Related Topics:
To view or edit a tape rotation job:



To view or edit a tape rotation job:
1. Click View Tape Rotation under the Job menu.    The Tape Rotation Jobs dialog box is displayed. 

2. Select the job you wish to view or edit and click on the Edit button.

Options for the fields in the Edit Tape Rotation Job dialog box are as follows:

Job name:

The name of the tape rotation job.

User name:

The name of the user that initially submitted the tape rotation job.

Selection file name

The name of the selection file    from which the tape rotation job was created.    

Today's Time:

The time the job is to run today.    You can change this field if you want to run the tape rotation job 
at a different time on a certain day.

Normal Time:

The time the job should run all other days.

Initial Date:

The date the first job in the tape rotation cycle was performed.

Target Partition Information

Select loader or multi-drive partitions where all full and non-full backups for this tape rotation job 
will be targeted.

Schedule Button

Press the Schedule button to display the Tape Rotation Schedule Options dialog box.

Advanced Button

Scan devices to estimate backup size - Select this option to have Backup Exec estimate the 
number of bytes to be backed up when the backup operation begins.    This option may cause the 
backup to take a little longer, but it allows you to monitor the progress of the operation (by 
percentage).

Submit job on hold - Select this option to submit the job with a hold status.    This is useful when 
you want to submit a job, but you are not ready for the job to run.

Console command before job (Administrator only) - This option executes a console command on 
the backup server before the job starts to run.    You can also specify a delay time to occur 
between the time the command is executed and the start of the job.    This option is only available 
during job submission and cannot be changed through job editing.

Console command after job (Administrator only) - This option executes a console command on 
the backup server after the job runs.    You can also specify a delay time to occur between the 
time the command is executed and the start of the next job.    



Tape Rotation Schedule Options
Weekly Schedule

Backup Exec's tape rotation strategy employs a combination of full and differential backups.    If 
you want to adjust the backup strategy you can do so.    For example, you can change the day 
your full backup is performed, schedule backups to take place over weekends, or use an 
incremental backup strategy instead of a differential.    To change the backup type for a particular 
day, move the highlight bar over the field you wish to change and press <Enter>.    You will be 
able to select None, Full, Incremental, or Differential for that particular day.    

Backup Cycle:

The cycle on which the backup schedule is based.    Options are weekly or monthly.    With a 
weekly backup schedule, your backup window would encompass approximately three weeks.    A 
monthly schedule encompasses approximately three months.

Treat backups:

This field allows you to determine how your backup tapes will be recycled.    Options are:

Recycle all tapes - Continue to overwrite all tapes as they are called for in the tape rotation cycle.

All fulls permanent - When a full backup is performed, the tape will be rotated out of the cycle 
(i.e., Backup Exec will not request the tape anymore; you will need to prepare a new tape to take 
its place).

Weekly permanent - If more than one full backup is scheduled during a week, the last full backup 
to take place will be considered a permanent backup and rotated out of the cycle.

Monthly permanent - The last full backup every month will be rotated out of the cycle.

Minimum Tapes Needed:

The minimum number of tapes that will be needed to complete the tape rotation cycle.    This 
takes into account the backup period, the number of backup periods per cycle, the number of 
initial full backups that should be performed, and the number of days in a week full backups are to
be performed.    It does not take into account the amount of data to be backed up, so you may 
need more tapes if one or more of your backups requires more than one tape.

Initial Number of Full Backups

The number of full backups assigned to begin the tape rotation cycle when the job was initially 
defined.

Backup Cycles per period

The number of time the backup period should be repeated before tapes are recycled.    When the 
backup period is weekly, this will be the number of weeks in the period.    When the backup period
is monthly, this will be the number of months in the period.

Temporarily suspend job:

If you want to keep Backup Exec from automatically submitting operations for this tape rotation 
job, mark this field.    

NOTE: This is not the same as placing jobs on hold in the Job Schedule.    When a tape rotation 
job is suspended, only that job will be held.    If other tape rotation jobs are scheduled, Backup 
Exec will continue to submit them.



Verify after: backup

Marking this field has Backup Exec perform a verify operation after each backup.

Full backup failure protection:

If a full backup fails to execute properly and this option is marked, Backup Exec will submit 
another full operation in place of the next scheduled differential operation.

3. Once a tape rotation job has been edited, all changes will take place with the next scheduled job. 



Tape Rotation Job Histories
Job histories for tape rotation operations are handled a bit differently than for regularly scheduled jobs.

The Job History window TR field lists the backup type of the tape rotation operation.    Available listings 
include: F = Full, D = Differential, I = Incremental.    Listing tape rotation jobs this way allows you to quickly
look through the Job History window to make sure the tape rotation jobs were submitted and completed 
on schedule.    The job history window also allows you to quickly see what tapes are needed to restore an 
entire device.

There are two ways to view tape rotation job histories in the Windows client:

    1. From the Tape Rotation Jobs menu

    2. From the View History item located in the Job menu.

Descriptions for fields in the Tape Rotation Run History windows are as follows:

Completion Time

The date and time the operation was completed. 

Backup Type

The backup type of the operation (i.e., full or differential).

Tape ID

The ID number assigned to the tape when it was prepared.

Sequence Range

The number of tapes in the tape family.    For example, if the backup spanned two tapes the range would 
be 001 - 002.

Set Range

The number of backup sets included in the tape rotation job.    For example, a backup of a typical server 
would consist of at least two backup sets, one for the bindery and one for each server volume.    Each 
device included in the tape rotation job will be included in an individual backup set.

History Detail

Script Name

The name of the script used when the tape rotation job was created.

Tape name:

The name supplied for the tape when it was prepared.

Status

How the job was completed.    Options are: 

· Normal - the job completed with no critical errors.

· Error - an error ocurred and the job was not completed successfully. 

· Aborted - the operation was aborted by the administrator or the Job Manager.

Start time:



The date and time the job began processing.

Total time:

The amount of time it took for the job to process.

Related Topics:
To view backup set detail for a tape rotation job:



To view backup set detail for a tape rotation job:
1. Move the selection arrows next to a job and press <Enter>.    The Job Set Information window 

displays.

The Job Set Information window lists information on each backup set included in a tape rotation 
job.

Tape name:

The name of the tape on which the backup set resides.

Set #

The order in which the backup set is included on the tape.

Sequence Range

The number of tapes in the tape family.    For example, if the backup spanned two tapes the range
would be 001 - 002.

Device name:

The device from which the data was backed up.

Status

The status of the operation.    Possibilities are: Normal - the job was completed with no errors, 
Error - errors were encountered while the job was processing, Aborted - the job was aborted while
it was processing.

Set Detail

Agent: The agent to which this set belongs.

Service: The service of the agent.

Object: The object of the agent.

Completion time: The date and time the job was completed.

3. Click the Tape Label button in the Tape Rotation Run History window.

Following are options for the Tape Label window:

Tape Name

The name supplied for the tape when it was prepared.

Location

Where the tape will normally be kept (on-site, off-site, etc.).

Lead Time

Lists the number of days in advance PROG_ABBR will request the tape before it is needed for 
the next TR job.

First Job

The name of the first tape rotation job stored on the tape.

Other Tape Rotation Jobs on this tape family



Lists other tape rotation jobs on the tape family.

Tape ID

The ID number assigned to the tape when it was prepared.

Sequence #

The sequence number of the tape in the tape family.    For example, if the tape rotation job 
spanned three tapes, the sequence would be 1, 2 or 3.

Backup Type

The type of backup operation the tape contains (Full, Differential or Incremental).

This tape is currently available

This field specifies whether the tape is currently available to be overwritten with another tape 
rotation job.    Tapes do not become available until a tape rotation cycle is completed.

This tape marked as permanent

This field shows if the tape was designated to be a permanent tape.



Submit Tape Rotation Dialog (Admin only)
This dialog box enables you to submit your tape rotation job to the backup server.

This window is displayed when the Backup Sources window is active and you select Submit Tape 
Rotation from the Job menu.

Related Topics:
Job Information
Backup Set Information



Job Information
Job Name

Name that identifies the job.

Day of Week to Perform Full Backups

Day of the week on which normal full backups should be done.    The default is Friday.

Execution Date

Date on which the tape rotation job will first execute.

Time

Time of day at which the tape rotation job will occur each day that it executes.



Backup Set Information
Device Name

Name of the device which you are backing up.

Set Name

Name of the backup set.    Give the backup set a name that is meaningful to you.

Set Description

Description of the backup set.    This name helps you to further identify the backup set.



Tape Rotation Jobs Dialog (Admin only)
This dialog box displays all of the tape rotation jobs defined for the current backup server. It provides the 
ability to edit, delete, and view the history of the tape rotation jobs.

This window is displayed when you select View Tape Rotation... from the Jobs menu.

Edit

Display the tape rotation job edit screen to allow the user to modify the selected tape rotation job(s).

Delete

Delete the selected tape rotation job(s).    Backup Exec prompts you to confirm the deletion of each job 
before removing it.

History

Display the run history information for the selected tape rotation job(s).



Tape Label Dialog (Admin only)
This dialog box displays information about the tape used for a run of a tape rotation job.

This window is displayed when you select Tape Label from the Tape Rotation History Dialog.

Related Topics:
User Defined Information



User Defined Information
Tape Name
Location
Lead Time



Tape Name
Name assigned to the tape during tape rotation tape preparation.



Location
Place where the tape rotation tape is stored.    This should be changed when the tape rotation tape is 
moved.



Lead Time
Number of days needed to retrieve the tape from location when it is needed.

First Job

Name of the first tape rotation job stored on this tape.

Other Tape Rotation Jobs On This Tape Family

Names of other tape rotation jobs stored on this tape family.

Tape ID

Unique identity assigned to the tape family.

Sequence #

Sequence number of the tape.

Backup Type

Type of backup operation that was performed on this tape (Full Backup, Differential, or Incremental).

This tape is currently available

The tape is currently available for use in a tape rotation job (it is not a permanent tape).

Delete

Remove this tape from the tape rotation cycle.    All tape rotation information referring to this tape will be 
removed as well.    Backup Exec will prompt for confirmation before the tape is deleted.



Job Sets Dialog (Admin only)
 
This dialog box displays information about the sets contained on a run of a tape rotation job.

This window is displayed when you select Set Detail from the Tape Rotation Run History dialog.

Set #

Position of the backup set on tape. 001 is the first backup set on tape.

Sequence Range

The range of tape numbers that the backup sets in this job were contained on.    The first number is the 
number of the tape the first backup set in this job was stored on.    The second number is the number of 
the tape the last backup set in this job was stored on.

Device Name

Name of the device contained on the backup set.

Status

Completion status of the backup (Normal, Aborted, or Error).

Set Detail

Agent

Name of the agent processed by the selected backup set.

Service

Name of the service processed by the selected backup set.

Object

Name of the object processed by the selected backup set.

Completion Time

Time and date the processing of the selected backup set finished.

Total Time

Amount of time it took to process the selected backup set.



Managing a Tape Rotation Job
Once your tape rotation job has been submitted, Backup Exec will keep track of when to run the backups 
and which tapes to use.    All you need to do is insert tapes when they are requested.    Simply look at 
Tape Rotation Tasks in the Admin menu to see what is needed for the next job and insert the appropriate 
tape in the drive.

Related Topics:
To monitor tape rotation tasks:



To monitor tape rotation tasks:
1. Select Tape Rotation Tasks in the Admin menu.    

2. Click on a task to see details for that task.    

The Tape Rotation Tasks window includes things you need to do in preparation for the next tape 
rotation job.    It tells which tape to provide for the job, and depending on the lead time entered 
when the tape was prepared, notifies you when a tape needs to brought in from an off-site 
location.

3. After a task is performed, it will automatically be removed from the system.    However, if you want
to manually delete a tape rotation task, select the task and press Delete.    Tasks are automatically
purged after seven days.

The following are possible task messages you may see:

Prepare more TR Tapes

More Tape Rotation prepared tapes are needed to perform tape rotation jobs.

[Job Name] is on hold.    [Tape ID].

The job indicated by [Job Name] on [Tape ID] has been placed on hold.    No other tape rotation 
jobs can run in this partition until the job is either executed or removed from the queue.

[Job Name] is Scheduled. [Tape ID].

The job has been placed in queue.    It lists the time and date the job will run, as well as the tape 
that will be needed for the job.    It also lists whether the job will be appended to the tape or if it will
overwrite the tape.

More jobs to be Scheduled

This message contains the list of other jobs that are supposed to be scheduled for today.

[Job Name] Return tape to.    [Tape ID].

This indicates that the Tape Rotation jobs for today have been completed.    This message notifies
you to return a tape to a particular location (i.e., offsite, vault, etc.).    This item lists the location 
you specified for the tape when it was prepared.

Jobs on Tape marked Permanent.    [Tape ID]

The indicated tape has beenmarked permanent.    This message will appear in the tasks window 
to let you know.    Once you receive this message, the tape will not be requested for overwrite 
again.

Tapes Needed onsite.

This message lets you know which tapes will be needed, the date, required, and the number of 
days until the tapes are requried.      The lead time of the tape determines when this message will 
appear. 

Where do I go from here.

          This message is the default message that will appear if there are no tape rotation jobs.    
It will instruct the user on what steps to do to get start processing tape rotation jobs.

Your 1st job tomorrow.



This item contains information to let the user know what the first job will be tomorrow and what 
tape is expected.    If    a specific tape is needed, the message will specify its Tape Id and Tape 
Name.

No jobs for tomorrow.

Informs the user that tape rotation has determined that there will be no tape rotation jobs 
scheduled for tomorrow.

Work finished for today.

This message informs the user that tape rotation has finished scheduling jobs for today.

No jobs to process today.

This task message informs the user that no tape rotation jobs are going to be processed today.    
This message is useful for those users scheduling new jobs on weekends, where by default, tape 
rotation does not schedule jobs.

NOTE:    The Tape Rotation Task List is automatically refreshed periodically.    When an attempt to
delete a task fails, it could be because the task has already been removed automatically, but the 
list has not yet been updated.    To update the list, click the Refresh button.

The Tape Rotation Tasks window should be checked everyday.



Restoring Files
You may have many reasons to restore data.    Perhaps you transferred data off your hard disk to create 
more storage space and now you need it back on your hard disk.    Maybe you deleted some data by 
mistake.    Maybe you replaced your hard disk, or acquired a new workstation. Or, perhaps your hard drive
has failed.    For whatever reason, Backup Exec makes it easy to retrieve your data.

Related Topics:
About Catalogs
Components
Selecting Data to Restore
Performing a Restore Operation (Admin)



About Catalogs
Backup Exec keeps track of the information you have backed up by maintaining catalogs.    Catalogs 
contain a record of the backup sets that have been placed on tape.    These catalogs provide security for 
Backup Exec; any user can only see and restore from those catalogs which he or she has backed up.    
Therefore, no other user can access data which you have backed up unless they know your Novell 
password or administrator password on the Backup Server.

There are three methods you can use to view the catalogs:

· The Restore Sources window.    You access this view by double-clicking on the Restore icon 
located at the bottom of your screen.

· The Tapes window (Administrator only).    You access this view by double-clicking on the Tapes 
icon located at the bottom of your screen.

· The Catalog Search function.    You access this view by selecting Catalog Search from the Admin 
menu, or by clicking on the Catalog Search button on the Selection Bar.



Components
Include
Exclude
File Specification
Selection Criteria



Include
Includes the specified devices, directories and files in the restore operation.



Exclude
Excludes the specified devices, directories and files from the restore operation.



File Specification
Device

Displays a list of devices available for the restore operation.    Only devices with backups in the catalog 
are included in this list.

Backup Set 

Specifies the backup set to be restored from the tape.

Path 

Specifies the directory or subdirectory to be selected.

File 

Specifies the file or files to be selected.    Wildcard characters are valid.

Include Subdirectories

Search all the directories beneath the specified path. 

For example, if your path is C:\, then all of the subdirectories in C: will be included.



Selection Criteria
All files

Includes/excludes all specified files.

Files dated within this range

Includes/excludes files within a specified time period.    

From  is the start date.

To  is the end date (inclusive).



Selecting Data to Restore
Follow these steps to perform a restore operation:

1. Double-click on the Restore icon located at the bottom of your screen.    This will open the 
Restore Sources window.

2. To open the Restore Sources window using the keyboard, press <Alt+W> to display the Window 
Menu.    Then, use the down arrow key to highlight Backup and press <Enter>.

The Restore Sources window displays catalogs sorted by device.    Any device that has been 
backed up appears in this list (if its catalog has not been deleted).    As a user, you will see only 
your own catalogs.    A check box is associated with each catalog name.    When you move the 
mouse pointer over the check box, the pointer changes to a pen.

3. Double-click on the device name to expand the tree and display the available volumes. 

4. If you want to display the individual backup sets created for the device, click on the device name.  
The program expands the Directory Tree window to display the backup sets in the right side of 
the window.

5. To display the individual directories and files created within a backup set, double-click on the 
backup set name.    The program creates a new Directory Tree window to display the directories 
within the backup set.    Double-click on a directory name to display the files contained within the 
directory.

6. You can quickly expand the Directory Tree window by selecting Expand All from the Tree menu, in
the Menu Bar.

7. Using the pen, click in the check box to select each backup set or individual directory or file you 
want to restore (or use the cursor movement keys to highlight your selections and press 
<Spacebar> to check them).

8. When selections are complete, click on the Restore button in the Selection Bar or select Submit 
Restore from the Job Menu.    This will open the Submit Restore Job window.    See the related 
topic, Submit Restore Job Window Components for options.

9. When selections are complete, click on OK to submit the job.    The program displays a message 
confirming that the job has been successfully submitted to the server.

10. Unlike a backup job, which can write to any tape in the tape drive, a restore job requires the 
specific tape containing the data you need.    If the correct tape is not in the tape drive, the Job 
Manager notifies the Administrator that the Backup Server needs attention.    If your restore job 
does not execute (if its status is "active" for an excessive amount of time), ensure that your 
network Administrator is available to change the tape in the drive.

Related Topics:
Submit Restore Job Window Components



Submit Restore Job Window Components
This dialog box enables you to submit your restore job to the backup server.

This window is displayed when the Restore Sources window is active and you select Submit Restore from
the Job menu, or click on the Restore button on the Selection Bar.

Job Name

Name that uniquely identifies this job.

Target Partition

The name of the partition which contains the tape to be restored.    To select another partition, press 
<Enter>.    A list of partitions that support restore jobs (and to which you have rights) will appear.

Eject tape after job (Admin only)

Select this option to have Backup Exec automatically eject the tape in the drive once the job is completed.
This function can be used in single or multiple drive configurations, but has no affect on loaders.

Execution Date

Date for the job to process.    Restore jobs are usually scheduled for immediate execution.    You can 
change this date by clicking on the up and down arrows beside the date.

Execution Time

Time for the job to process.    You can change this time by clicking on the up and down arrows beside the 
time.

Set Description

Contains information about the backup sets that will be restored.    Note that, if multiple sets are being 
restored, you should use the scroll bars on the right side of this box to move to the additional sets and 
enter their restore information.

Set Name

Name that was given to the backup set when the backup was performed.

Set Type

Identifies the type of backup performed for this set.

Backup of

Device from which the backup was made.

on

Date and time the backup was processed.

Restore to Device

Device to which you want to restore the data.    This list only includes items contained in the password 
database, or items to which you have attached during this session.    Note that some device limitations 
apply.    For example, if you have backed up an SMS Agent for Directory Services, you cannot restore that
data to a Backup Exec Agent.

Restore to Path

Path to which you want the data restored.    Backup Exec places this path in front of the path names 



associated with the data you are restoring.    For example, if the data files are prefaced with a path name 
of \BKUPEXEC and you assign a Restore To Path name of \NEW, the files will be given a path name of \
NEW\BKUPEXEC.    If the path does not exist, Backup Exec will create it for you.

Restore all files to this path

Checking this box will cause all of the files being restored to be placed in the directory specified by the 
Restore to Path field.    For example, if you were restoring the \BKUPEXEC\NEW\MYFILE.TXT file and 
the Restore to Path field contained \RESTORE, the result of the restore operation would be that 
MYFILE.TXT would be restored to the \RESTORE directory.    If you had not checked this box, the result 
would be that the MYFILE.TXT file would be restored to the \RESTORE\BKUPEXEC\NEW\MYFILE.TXT 
directory.



Performing a Restore Operation (Admin)
The steps that Administrators follow in performing a restore operation are identical to those followed by 
users.    However, the Restore Sources window will display all available catalogs.



Searching a Catalog
Backup Exec keeps a list of the files included in each backup in its catalog.    Finding a single file or group 
of files among many backup sets could be difficult and time consuming.    To speed up this process, 
Backup Exec has a "Search" feature that lets you find files to restore easily.

Follow these steps to search a catalog for one or more files to restore:

1. Select Catalog Search from the Admin menu, or click on the Catalog Search button on the 
Selection Bar.    This opens the Enter Search Criteria window.    See the related topic, Enter 
Search Criteria Window Components for options.

2. Specifying at least the first character of the filename(s) will speed up the search process.    For 
example, if you wanted to search for all files that began with the letter "A", type a* in the "File" 
field.

3. When you finish entering search criteria, click on OK.

4. Depending on how specific your search criteria are and how large your catalogs are, it may 
require several seconds for the program to complete the search.    The search encompasses all 
available catalogs.

When the search is complete, the program displays the Search Results window.

5. The Search Results window displays all of the files that matched the criteria specified for the 
search.    A small check box appears to the left of each file name.    When you move the cursor 
near one of these check boxes, the cursor turns into a pen.    Use the pen to mark the files that 
you wish to restore.

6. Once all files have been selected, click on the Restore button in the Selection Bar or select 
Submit Restore from the Job Menu.    This opens the Submit Restore Job window.    You may now 
proceed to submit the restore job as usual.

Related Topics:
Enter Search Criteria Window Components



Enter Search Criteria Window Components
Options for the items in the Enter Search Criteria window are as follows:

Path 

If you know which directory the file was in when the device was backed up, enter it in the "Path" field.    By
specifying the path, you can search any available directory, or subdirectory.    For example, you could 
locate the \bkupexec\DOS_WS subdirectory in the selected device's backup sets by typing \sys\apps in 
this field.

File

This field is used to search for any specific file or files.    For example, you could search for all files with 
the .BAK extension by entering *.bak in this field.



Advanced File Selection - Restore
Advanced file selection enables you to quickly select groups of files to be included in or excluded from 
your Restore operations.

To make your Advanced File Selections, follow these steps:

1. Select the device(s) you want to restore.

2. Click on the Select in the Menu Bar and click on Advanced or click on the Advanced File 
Selection button in the Selection Bar.    

This opens the Advanced File Selection - Restore window.    See the related topic, Advanced File 
Selection - Restore Window Components, for selections.

3. When your selections are complete, click on OK.

The program redisplays the Restore Sources window.    The devices, services and volumes 
containing selections matching your criteria are now selected.

4. Click on the Restore button on the Selection Bar or select Submit Restore from the Job Menu to 
display the Submit Restore Job window.    You may now proceed to submit the job as usual.

Related Topics:
Advanced File Selection - Restore Window Components



Advanced File Selection - Restore Window Components
The following choices are available in the Advanced File Selection - Restore window:

Include or Exclude Files

Select whether to Include or Exclude all files that meet your file specifications.    The default is Include.    
Click on Exclude if you want to exclude files from the operation.

File Specification

Specify where Backup Exec should look, and what to look for, when selecting files that will be included in 
or excluded from your Restore operation.

Device

Select the device that contains the files you want to include or exclude.    The field contains the name of 
the device you chose through the Restore Sources window.    Click on the down arrow located to the right 
of the device field to scroll to other available devices.

Backup Set

Name identifying the group of backed-up directories and files, as assigned when the backup was 
submitted.

Path

Enter any available directory or subdirectory on the device selected.    Enter the full path to the 
subdirectory (do not include the device identifier).    For example, if you have selected drive C, and the 
data you want to restore is in the MEMOS subdirectory of the DOCS directory, your full path would be C:\
DOCS\MEMOS.

File

Specify any files to be included or excluded.    Wildcard characters are permitted.    The asterisk (*) in a file
name or extension is a wildcard character that represents all characters occupying any remaining position
in the file name or extension.    The question mark (?), the wildcard for a single character, is also 
supported.

For example, to include all files with the .EXE extension, type the following:

*.EXE
The default for File is *.*, which means every file name with every extension will be selected.

Include Subdirectories

Choose Include Subdirectories to include all subdirectories contained within all directories that are part of 
your selections.

If the operation is beginning at the root level of a disk (e.g., drive C:), all directories and subdirectories on 
that disk will be included.    If you entered a specific path (directory), all of the subdirectories contained 
within that directory will be included.

Selection Criteria

Specifies the files to be included in the backup operation:

· All Files - Choosing All Files will include all files in the restore operation.    All Files is the default.



· Files Dated Within This Range - Choosing Files dated within this range will include or exclude 
all files that were changed or created within the specified range of dates.    Specify a beginning 
(From) and an ending (To) date.



Displaying File Versions
The File Version feature enables you to display a list of all versions of a file that has been backed up to 
tape.    Using this feature, you can quickly identify which version of a file you want to restore.

Follow these steps to use the File Version feature:

1. Select the file through either the Tapes window or the Restore Sources window.

2. Select Display Info from the Admin menu, or click on the File Version button on the Selection Bar.

3. As a shortcut, you can also double-click on a file name.    This displays the Search Results 
window.    See the related topic, Search Results Window Components for options.

Backup Exec searches all of the tape catalogs and lists the file version(s).    

NOTE:    If Backup Exec is taking a long time to search for the file version information, you can hit
<Esc> to quit the search.    Any version information already found, if any, will be displayed.

4. Select the version of the file you want to restore and click on the Restore button on the Selection 
Bar, or select Submit Restore from the Job menu.    This will open the Submit Restore Job 
window.    

5. Proceed to submit the job as usual.

6. If you return to the Restore Sources window after selecting a file version, you will notice that the 
volume containing that version has been automatically selected for you.

Related Topics:
Search Results Window Components



Search Results Window Components
The Search Results window displays the following information:

· File Name

· File size (in bytes)

· Date the file was created or last modified

· Time the file was created or last modified

· Path and backup set containing the file

· Name of the tape containing the file

· Volume from which the file was backed up

· Add Set #    - The backup set number of the set that contains the file

· Add Bset Name - The backup set name of the set that contains the file



Editing a Restore Job
Backup Exec enables you to change information for a scheduled restore operation.    You can edit only 
those jobs which are in Ready or Hold status; you cannot edit active jobs.    If you are an administrator, 
you can edit any job in the queue.    If you are not an administrator, you can edit only those jobs which you
have submitted.

Follow these steps to edit a Restore job:

1. Display the Job Schedule window by either selecting View Schedule from the Job menu, or by 
clicking on the Job Schedule icon.

2. Highlight the job you want to change by clicking on it. 

3. Click on the Edit button at the bottom of the window.    This opens the Edit Restore Job window.    
See the related topic, Edit Restore Job Window Components for options.

4. When your changes are complete, click on OK to save them and close the window.
Edit Restore Job Window Components



Viewing Tapes (Administrator Option)
If you are an Administrator, the Windows Client enables you to review the contents of the catalogs sorted 
by backup tape.    This capability is especially useful for reviewing the contents of a cataloged tape before 
you delete it.

Note:    You cannot make file selections for restore jobs while viewing tapes.    To make file selections for 
restore jobs, you must go to the Restore Sources window.

To view tapes:

1. Click on the Tapes icon on your Windows Client desktop.    This opens the Tapes window.

2. To open the Tapes window using the keyboard, press <Alt + W> to display the Window Menu.    
Then, use the down arrow key to highlight Tapes and press <Enter>.

The Tapes window lists each cataloged tape on the left-hand side, by tape name.    If the catalog 
spans multiple tapes, an icon showing more than one tape is displayed.    The right-hand side of 
the window lists the backup sets that are contained on the tape(s), by backup set name.

3. To view the contents of a backup set, double-click on the volume name in the right-hand side of 
the window.

This expands the view to show the cataloged directories on the tape in the left-hand side of the 
window, with the subdirectories and files shown on the right-hand side of the window. 

4. Double-click on the directory icon to further expand the view and show the files it contains.

5. When you have finished viewing tape contents, close the Tapes window by clicking on the control 
box in its upper left hand corner.



Job Schedule
The Job Schedule window includes jobs that are in the Backup Manager queue waiting to be processed. 
While in this menu, you can:

· view jobs you have submitted

· view all jobs in the Backup Manager queue

· edit job information

· delete jobs

· place jobs on "hold"

· monitor active Job Manager sessions

To view the Job Schedule: 

1. Select View Schedule from the Job menu, or click on the Job Schedule button on the Selection 
Bar.    This opens the Scheduled Jobs window.    See the related topic, Scheduled Jobs Window 
Components for options.

2. As a user, you can choose to view all jobs in the queue or only your own jobs.    However, if you 
attempt to edit a job that is not your own, you will not be able to save the edits.

Related Topics:
Scheduled Jobs Window Components
Session Status Window



Scheduled Jobs Window Components
This option displays a list of jobs that are scheduled to be processed.    Using this option, you can check 
the status of a job's processing, place jobs on hold, activate jobs on hold, and delete jobs.

This window is displayed when you select View Schedule from the Job menu, or click on the Job 
Schedule button in the Selection Bar.

Your Jobs

Select this option if you want to view only those jobs you have submitted.

All Jobs

Select this option if you want to view all jobs in the queue.    

Job Name

The name assigned to the job when it was submitted.

TR

Type of operation for tape rotation jobs.    The types are (F)ull, (D)ifferential, and (I)ncremental.

Operation

The type of operation to be performed (i.e., Backup, Restore).

User Name

The name of the user that submitted the job.

Start Time

The time and date the job is to be run.

Status

The status of the job in the queue. Options are:

· Hold - the job has been placed on hold

· Ready - the job is ready to be processed when it is reached in the queue

· Active - the job is currently being processed

· Partition Hold - the target partition for the job is on hold

Job Details

Detailed information about the currently highlighted job.    If multiple jobs are highlighted, an outline is 
displayed around the job to which the details apply.    This box contains information only while the list of 
jobs is the active element on your screen.

· Submitted - Date and time this job was submitted to the server.

· Frequency - Indicates how often the job is to be processed.

· Backup Type - Identifies the kind of backup to be performed (normal, incremental, differential, or 
copy).

· Target Partition - The partition designated for the job.

· Eject Tape - Indicates whether Backup Exec should eject the tape when the operation 



completes..

· Verify After - Indicates if a Verify operation should be performed after the backup completes.

Close

Closes the Scheduled Jobs window and returns to the application.

Edit

Opens a dialog box enabling you to edit the parameters of a job.    If you select more than one job and 
press the EDIT button, you can edit each job in succession.    When you finish editing the first job, press 
OK or CANCEL to display the next job.

Resume Job

Activates a job that was placed on Hold.    If you have selected multiple jobs and press this button, all the 
selected jobs are set to Ready.

Hold Job

Changes a job's status from Ready to Hold.    Jobs on hold cannot run until they are resumed (through the
Resume button).    If you select more than one job and press the HOLD button, all the selected jobs are 
placed on Hold.

Delete Job

Deletes the selected job(s).    Backup Exec prompts you to confirm the deletion of each job before 
removing it from the job queue.    You cannot delete active jobs.

Monitor Sessions

The Monitor Sessions button allows you to view activity occurring on the Job Manager console from your 
workstation.    Administrators can use this option at any time; users can view the Job Manager when their 
job is active in the queue.



Session Status Window
The Session Status window shows information for each session.    This information includes, the session's
status, the partition on which the operation is being performed, the job name and the operation type.    To 
view details for the job being processed, click the View button to activate the Job Information window.

You can not view the status of utility operations that are running at the server.

If the last operation performed by the sessionr didn't generate any completion statistics (e.g. a tape eject, 
rewind, or quick erase operation), you will get an error message indicating that there are no completion 
statistics available when you click on the View button.

If the Job Manager is taken offline or unloaded while you are in this dialog, you will get an error message 
indicating that the Job Manager has been taken offline, and the dialog will be cleared.    You can not view 
session status while the Job Manager is offline.

Session

The session number

Status

The current status of the session.

Ready - Indicates that the session ready, but there are no jobs 
that currently need to be processed.

Active - Inidcates that the session is performing an operation

Blocked - Indicates that the session is waiting for operator 
intervention.    For example, it may be requesting that a tape be 
placed into the drive.

Drv Failed - Indicates that the session encountered an error from
which it could not recover.    This session can not be used until 
the problem at the server is resolved.

Rerouting - Indicates that this session is has encountered a 
failure situation and is attempting to reroute jobs.    The session 
status will remain Rerouting until the failure is resolved at the 
server.

Partition

The name of the partition that is being used by this session

Job Name

The name of the job that is being processed in this session.    Note that if a utility operation (catalog, 
verify, etc) is being performed at the server, the job name field will be blank.

Operation

The operation being performed.    For example, Backup, Restore, Catalog, Verify

View Button

If you want to get more information about a session, highlight the session, and click on the view button.    
If the session is active when you click on the View button, the Job Information dialog will be displayed with



information about the current job.    If no job is currently running, the Job Completion Statistics dialog will 
layed with information about the last operation that was performed.

Related Topics:
Job Information Window
Job Completion Statistics Window



Job Information Window
The Job Information window lists specific information about the job being processed.    The contents of the
window depend on the type of operation being performed as well as by the options selected for the 
current job.

Job Type

Indicates the type of job being performed (e.g. Backup,    Restore, File Grooming)

Started

The time that the session started processing the job

Elapsed Time

The amount of time that the session has been processing the current operation

Tape Name

The name of the tape that is being used in the operation

Tape ID

The ID of the tape being used in the operation

Tape Sequence

The sequence number of the tape being used in the operation

Set on Tape

The number of the current backup set that is being processed

Partition

The name of the partition that is being used by this session

Submitted By

The name of the user that originally submitted the job

Operation Boxes

Depending on the type of operation that is being performed, you will see different types of operation 
boxes.    If a backup operation is being performed, the Operation Box name will be Backup.    If a verify 
operation is being performed the Operation Box will be named Verify.

Device

The device (or Agent) that is being processed.    For example, if this is a backup operation, the device 
would be the agent that is being backed up.

Current Dir

The name of the directory that is currently being processed

Current File

The name of the file that is currently being processed.    Note that if you are backing up small files, you 
may not see all of the files show up in this field.    This does not indicate that a file was not backed up.    It 
only indicates that there wasn't enough time to display its name.

Total - Directories



The number of directories that have been processed

Total - Files

The total number of files that have been processed

Total - Bytes

The total number of bytes that have been processed

Estimations

The estimates for total bytes and percentage complete are only shown if the estimates have been 
generated.    For backup operations, the estimates are shown if the current job used the "scan devices to 
estimate backup size" option (in the advanced job options).    Verify operations that follow a backup 
operation always have the estimate available.    Restore operations do not have time estimates.

Note: The values for some of these fields are not known until certain steps have been completed.    For 
example, during initialization, the Currrent Dir field is blank because no directory is currently being 
backed up.

Note: When the job that is being processed completes, the Job Completion Statistics dialog box is 
automatically displayed.



Job Completion Statistics Window
The Job Completion Statistics window lists information about the completed job.    Check the job status to 
make sure the job completed normally.    If the job ended with an error, check the Job History to find out 
why.

Status - This is the final status of the job.

· Normal - Job terminated normally

· Error - Job encountered an error during execution.

· Aborted - Job was aborted by the user.

Operation Boxes

Depending on the type of job that is being processed, you will see different types and numbers of 
operation boxes.    Following the tile of each operation box is the amout of time that it took to perform each
of the operations.    Each of these operation boxes will have one or more of the following fields.

Devices

The number of devices that were backed up or restored.

Throughput

The rate at which information was transferred for this operation

Directories

The total number of directories processed during the operation

Files

The total number of files processed during the operation

Bytes

The number of bytes processed



Editing Jobs in the Queue
Active jobs cannot be edited.    As a user, you can edit only those jobs which you have submitted which 
are in Ready or Hold status.    You can display the Edit window for any job, but you cannot save changes 
to other users' jobs.

For details on a specific job: 

1. Click on a job to highlight it and then click on the Edit button, or simply double-click on the job.    
This will open the Edit window.      See the related topic, Edit Backup Job Window Components for
options.

2. To change how often a backup job occurs, click on the Frequency button to the right of the Edit 
Backup Job window.

This window displays the current job frequency information and allows you to edit it. 

3. When you finish editing the frequency, click on OK to return to the Edit Job Information window.

4. Press the Advanced button to configure advanced options for the job.

5. Once you have completed editing the job, click on OK. The job will remain at its place in the 
queue unless you changed the execution date and time.

Related Topics:
Edit Backup Job Window Components
Job Frequency Information Window Components
Edit Restore Job Window Components
Edit File Grooming Job Window Components
Placing Jobs on Hold
Deleting Jobs From the Queue
Job Schedule - Administrators



Edit Backup Job Window Components
For backup jobs, the Edit Backup Job window resembles the following:

Job Name

Enter a name that will differentiate this job from others in your job history records. Maximum length for the
job name is 24 characters.

Target Partition

The first available partition (that allows the user, and the type of operation being performed) is selected as
the default partition.    Press <Enter> in the Target Partition field to display other partitions on which the job
can be processed.    Move the selection arrows next to the desired partition and press <Enter>.

Backup Type

There are four backup types :

· Normal (default) - backs up all selected files and changes the files' status to "backed up".

· Incremental - only backs up selected files that were modified or created since the last Normal 
backup.    Selecting Incremental will also change the files' status to "backed up".

· Differential - only backs up selected files that were modified or created since the last Normal 
backup.    Selecting Differential does not affect a file's backup status.

· Copy - backs up all selected files, but does not change their backup status.

Verify After Backup

Selecting this option has Backup Exec check to make sure the files you wrote to the tape can be read 
once a backup has been completed.    You should leave this item marked.

Current Frequency

Indicates how often the job is to be run.    To change this value, click on the Frequency button at the right 
of the window.

Advanced button

Scan devices to estimate backup size - Select this option to have Backup Exec estimate the number of 
bytes to be backed up when the backup operation begins.    This option may cause the backup to take a 
little longer, but it allows you to monitor the progress of the operation (by percentage).

Submit job on hold - Select this option to submit the job with a hold status.    This is useful when you want 
to submit a job, but you are not ready for the job to run.

Console command before job (Administrator only) - This option executes a console command on the 
backup server before the job starts to run.    You can also specify a delay time to occur between the time 
the command is executed and the start of the job.    This option is only available during job submission 
and cannot be changed through job editing.

Console command after job (Administrator only) - This option executes a console command on the 
backup server after the job runs.    You can also specify a delay time to occur between the time the 
command is executed and the start of the next job.    

Execution Date

Date the job is scheduled to process.    You can change this value by clicking on the up and down arrows 



to the right of the value.

Execution Time

Time the job is scheduled to process.    You can change this value by clicking on the up and down arrows 
to the right of the value.

Related Topics:
Edit Backup Job Window - Administrator View



Edit Backup Job Window - Administrator View
The Administrator view of the Edit Backup Job window includes fields not shown in the user view:

New Tape Name

Enter a name that identifies a tape.    If this is an overwrite job, this name will be used as the new name 
for the tape.    If this is an append job, and the tape in the drive is blank when this job is run, this value will 
be used as the name of the tape.    If the job is appended to a tape that already has data on it, this name 
will not be assigned to the tape.

New Tape Password

Enter a password to prevent unauthorized access to the tape.    If this is an overwrite job, the tape 
password will be used as the new password for the tape.    If this is an append job, and the tape in the 
drive is blank when this job is run, this value will be used as the tape password.    If the job is appended to
a tape that already has data on it, this password will not be used.

Operation

Defines the way the backed-up information will be placed on the tape.

· Append - Data will be added after that already existing on the tape

· Overwrite - Data will be written over that already existing on the tape

Verify After Backup

Selecting this option has Backup Exec check to make sure the files you wrote to the tape can be read 
once a backup has been completed.

Eject Tape After Job

Select this option to have Backup Exec automatically eject the tape when the operation is completed.



Job Frequency Information Window Components
The Job Frequency Information window contains the following:

Execute Only Once

Select this option if you want the job to process one time only.

Repeat Every [ ] Days

Select this option if you want the job to repeat after a given interval, beginning with the specified 
execution date. Enter the number of days to elapse between jobs in the space provided. For example, 
you can choose to run a job every 14 days.

Repeat Every [ ] Weeks On

Select this option if you want the job to repeat at a given weekly interval on the day(s) of the week 
specified. For example, you can choose to run a job every two weeks on Friday. Note that this schedule 
may change the execution date. If so, the date is set to the next date that falls within the date range.

Repeat Each Month On

Select this option if you want the job to repeat on a specified day each month. For example, you can 
choose to run a job on the 15th of every month. You can also enter "L" to schedule a job for the last day of
each month. Note that this schedule may change the execution date. If so, the date is set to the next 
month whose nth day has not yet been passed.



Edit Restore Job Window Components
The Edit Restore Job window enables you to change the following information:

Job Name

Name that uniquely identifies this job.

Target Partition

The target partition assigned for the restore job.

Execution Date

Date for the job to process.    Restore jobs are usually scheduled for immediate execution.    You can 
change this date by clicking on the up and down arrows beside the date.

Eject Tape After Job (Administrator only)

Select this option to have Backup Exec automatically eject the tape when the operation is completed.

To view or change the following Advanced Job Options, click on the Advanced button. 

Time

Time for the job to process.    You can change this time by clicking on the up and down arrows beside the 
time.

To view or change the following Advanced Job Options, click on the Advanced button. 

Submit job on hold - Select this option to submit the job with a hold status.    This is useful when you 
want to submit a job, but you are not ready for the job to run.



Edit File Grooming Job Window Components
This dialog box enables you to edit a file grooming job to the backup server.    File grooming capabilities 
are available to Administrators only.

Job Name

Enter a name that will differentiate this job from others in your job history records.

New Tape Name - Enter a name that identifies a tape.    If this is an overwrite job, this name will be used 
as the new name for the tape.    If this is an append job, and the tape in the drive is blank when this job is 
run, this value will be used as the name of the tape.    If the job is appended to a tape that already has 
data on it, this name will not be assigned to the tape.

New Tape Password - Enter a password to prevent unauthorized access to the tape.    If this is an 
overwrite job, the tape password will be used as the new tape password for the tape.    If this is an append
job, and the tape in the drive is blank when this job is run, this value will be used as the tape password.    
If the job is appended to a tape that already has data on it, this password will not be used.

Target Partition - The target partition tells Backup Exec where you want this job to be performed.    If you 
have multiple backup devices or a loader attached to the current backup server, you may be able to 
perform this job on any one of several partitions.    Note that partitions can be restricted to specific users 
or job types.    So, if a partition which you know exists does not show up in the Target Partition drop down 
list, it is probably because the partition either does not support the current job type or you do not have 
access to the partition.    If you do not care which partition is used, you can use the "First Available" option
which will cause the job to be run on the first available partition that supports the job.

Backup Type

For file grooming operations, Copy is the only valid backup method.

Eject tape after job (Admin only)

Select this option to have Backup Exec automatically eject the tape in the drive once the job is completed.
This function can be used in single or multiple drive configurations, but has no affect on loaders.

Groom files not accessed in [ ] days

Specifies the number of days that a file should be dormant before being backed up and removed from 
disk.    The program will groom only the files that have not been read or created during this many days.

Current Frequency

Indicates how often the job is to be run.    To change this value, click on the Frequency button at the right 
of the window.

Operation

Determines how the groomed file will be added to the backup tape:

· Append - Add files at the end of the tape, leaving existing files intact

· Overwrite - Replace files on the tape with the groomed files

Execution Date

Date the job is scheduled to process.    You can change this value by clicking on the up and down arrows 
to the right of the value.



Execution Time

Time the job is scheduled to process.    You can change this value by clicking on the up and down arrows 
to the right of the value.

Frequency

Click on this button to change the schedule for the job.



Placing Jobs on Hold
You can place a job on hold for as long as you like. This is useful when you have a regularly scheduled 
job that you want to suspend temporarily, but not delete. To hold a job, highlight it and click on the Hold 
Job button. You will notice its status change to "Hold". When you are ready for the job to run again, 
highlight it and click on the Resume Job button.

Active jobs cannot be placed on hold.



Deleting Jobs From the Queue
To delete a job, highlight it and click on the Delete button. If you select multiple jobs to delete, Backup 
Exec displays a dialog box asking if you want to delete all of the highlighted jobs.    If you answer "Yes", all
of the jobs are deleted.    Otherwise, Backup Exec displays a confirmation dialog asking you to verify the 
deletion of each job.    Active jobs cannot be deleted.



Job Schedule - Administrators
Administrators follow the same procedures as users to display and work with the Job Schedule window.    
However, the Administrator has the ability to display and edit all jobs in the queue.



Job History
The Backup Exec Job History contains summary information for backup and restore jobs. This allows you 
to keep track of the jobs completed by the Backup Manager.    As a user you will see only your own jobs.

To display the Job History window:

1. Select View History from the Job menu, or click on the Job History button in the Selection Bar.    
This opens the Job History window.    See the related topic, Job History Window Components for 
options.

2. For details on a specific job, click on the job to highlight it and then click on the View button.    See
related topic, Job History File for options.

3. You can configure the level of detail for your Job History entries.

4. You can print the contents of the Job History by selecting Print from the File Menu when this 
window is active.

5. When you finish specifying filters, click on OK to close the window and apply the filters.

6. Filters do not reset within a single Backup Exec session.    For example, if you apply a filter to 
show only jobs with errors, that filter will remain in effect every time you view Job History within 
that session.    If you exit and return to Backup Exec, the filters reset to their defaults.

Related Topics:
Job History Window Components
Job History File
Printing a Job History File
Understanding Job History Results
Filtering Job History Information
Deleting Job History Entries
Job History - Administrators



Job History Window Components
The jobs in the Job History window are listed in chronological order, beginning with the job most recently 
completed. Following are descriptions for each field:

Job Name

The name assigned by the user when the job was submitted.

TR (Admin Only)

Type of operation for tape rotation jobs.    The types are (F)ull, (D)ifferential, and (I)ncremental.

Operation

The type of operation performed.

User Name

The name of the user that submitted the job.

Completion Time

The date and time the job finished processing

Status

The overall results of the job. Options are Normal, Error, or Aborted.

· Normal - Job terminated normally

· Error - Job encountered an error during execution

· Aborted - Job was aborted by the user

Close

Closes the View History window and returns to the application.

View

Displays a View Logs window containing the history for the selected job.

TR History (Administrators only)

Displays the run history for the selected tape rotation job

Delete

Removes job history files for the specified jobs.    You can select single or multiple job histories to delete; 
Backup Exec prompts you to confirm each deletion.

Related Topics:
Filters



Filters
Accesses the Filters window, which enables you to limit the range of job histories that you want to display. 
You can display history by operation, by user (administrator only), by specific job name, or list only jobs 
with errors.

This window is displayed when you click on the FILTERS button at the bottom of the Job History window.

Jobs

All jobs

Select this option to display all jobs.

Specific job

Select this option to display an individual job.

Jobs with errors only

Select this option to display only those jobs containing errors.

Operations

Backup

Select this option to display backup jobs.

File Grooming (Administrator only)

Select this option to display file grooming jobs.    

Restore

Select this option to display restore jobs.

Tape Rotation (Administrator only)

Select this option to display tape rotation jobs.

Users (Administrator only)

All users

Select this option to display jobs submitted by all users.

Specific user

Select this option to display jobs submitted by a specific user.    Enter the user ID in the field provided.



Job History File
In this window, you can view the comprehensive job history file. The history file includes the following 
information:

· Job Name - The name assigned to the job.

· User Name - The name of the user that submitted the job.

· Operation - The type of operation performed.

· Submitted - The date and time the job was submitted.

· Operation Started -      The date and time the job was run by Backup Exec.

· Tape ID n Tape name -      The tape number and name assigned to the tape set.    Refer to the 
Administrator Manual for a description of this field's usage.

· Set n Set name -      The set number on the tape and the backup set name.

· Set description - The description provided for the backup set.

· Partition Name - The name of the partition used for the operation.

· Total devices -    The number of devices included in the operation.

· Total bytes -      The number of bytes (and Megabytes) processed.

· Total time -      The amount of time the operation took to process.

· Throughput -      The amount of bytes per second/MB per minute.

· Total bytes used on this media -      The number of Megabytes used on this tape.

· Total bytes left on this media -      The number of Megabytes remaining on the tape.

· Software compression ratio -      If software data compression has been enabled, this message 
will display the compression ratio.    For example: a 2:1 ratio indicates that your data was 
compressed to half its original size.    The larger the number on the left, the more your data was 
compressed.

· Operation Ended -    The date and time the operation ended.

· Job Completion Status -    The Job Completion Status field tells you whether the job was 
completed successfully. Options are:

· Normal - the job completed with no critical errors

· Error - an error occurred and the job was not completed successfully. Try submitting the job 
again.

· Aborted - the operation was aborted by the administrator or the Job Manager. 

If the administrator enabled the Job Manager's Job Rerouting feature, and the target partition of 
your job was unavailable at the time the job was run, your job may have been re-routed to 
another server.    If this happens, your job history will contain information about where the job was 
re-routed to.    If your job has been re-routed, you will need to change to the backup server (using 
the Change Backup Server menu) to which your job was routed in order to get the final results of 
this job.



Printing a Job History File
Before you can print a Job History file, a printer must be attached to your system and you must use 
File/Printer Setup to tell your system what printer to use.    To print a Job History:

1. Double-click on the Job History icon.

2. Click on the job whose history you want to print.

3. Click on View (within the dialog box).

4. From the File Menu, choose Print.



Understanding Job History Results
What does the completion status mean?
What happens to jobs with errors?



What does the completion status mean?
There are three possible job completion statuses:    Normal, Aborted, and Error.

· Normal means your job ran fine.    

· Aborted means that the job did not run to completion.    Here are some reasons a job might be 
aborted:

· errors were found processing the device information associated with the job

· no devices specified by the job were available when the job was run

· errors were found with the login information associated with the job

· there was a problem with the tape drive when the job was run

· the job information was corrupted

· the administrator terminated the operation as it was running

· Error means that the operation took place, but one or more significant errors occurred.    The job 
history log should indicate what caused the errors and you can decide if you want to run the job 
again.    For example, an error will be reported if the connection is lost to a device while it was 
having an operation performed on it.    Depending on the importance of the file, you may choose 
not to run the job again.



What happens to jobs with errors?
A once-only job that ends in an Aborted or Error status will be put back in the queue on hold so that if you 
want to try running the job again you can go to the Job Schedule and toggle the job to Ready by pressing 
<Ctrl + T>.    If you do not want to run the job again, delete the job by pressing <Del>.

A continual job that ends in an Aborted or Error status will be rescheduled for its next execution time.    If 
the user wants to run this iteration of the job, the execution time for the job can be modified in the Job 
Schedule window.



Filtering Job History Information
You can apply filters to narrow down your view of the Job Histories that are available.

To apply filters:

· Click on the Filters button at the bottom of the Job History window.    This opens the Filters 
window.    See the related topic, Filters Window Components for options.

Related Topics:
Filters Window Components



Filters Window Components
The Filters window offers the following options:

· Jobs - Identifies the types of jobs you want to include in the Job History view:

· All Jobs - Include all jobs that have processed

· Specific Job - Show only the specified job; enter the job name in the space provided

· Jobs with errors only - Show only jobs in which errors occurred

· Operations - Identifies the type of operations you want to include in the Job History view:

· Backup - Show backup jobs

· Restore - Show restore jobs

You can specify any combination of filters to apply.    For example, you can choose to display only backup 
jobs that contain errors.



Deleting Job History Entries
After making sure your job has run successfully, you may want to delete the job history entry.    

To delete Job History entries that you no longer wish to keep:

1. Highlight the job by clicking on it, then click on the Delete button.    Backup Exec displays a 
confirmation dialog asking you to verify or cancel the deletion.      

2. To delete more than one entry, hold down the mouse button and drag until all the entries you want
to delete are highlighted.

3. Click on the Delete button.    If you selected multiple histories to delete, Backup Exec displays a 
dialog box asking if you want to delete all of the highlighted history entries.    If you answer "Yes", 
all of the history entries are deleted.    Otherwise, Backup Exec displays a confirmation dialog 
asking you to verify the deletion of each history entry.



Job History - Administrators
Administrators follow the same procedures as users to display Job History.    However, Administrators 
have the ability to view history records for all jobs.

Administrators are also able to apply additional filters to limit their view of the Job History records.

The additional filters include:

· Operations

· File Grooming - Show file grooming jobs

· Users - Identifies the users whose jobs you want to include in the Job History view:

· All Users - Include jobs submitted by all users 

· Specific User - Include only jobs submitted by the specified user; enter the user name in the 
space provided



Change Backup Server
Your workstation may be attached to multiple backup servers. The Change Backup Server function allows
you to choose another file server running the Job Manager for Backup Exec functions.

To change your backup server:

1. Select Change Backup Server from the Admin menu, or click on the Change Backup Server 
button on the Selection Bar.    This will open the Change Backup Server dialog box.    This dialog 
box lists the backup servers to which you are currently attached.    See the related topic, Change 
Backup Server Dialog, for details.

2. Your current backup server is highlighted. To select a different server, highlight it and click on OK, 
or simply double-click on the server name.

3. If you change to a backup server on which you are assigned different rights, information on your 
Windows Client screens may change. For example, if you are an administrator and change to a 
backup server on which you have user privileges only, some of the fields that displayed previously
will not be available.

Changing backup servers redraws the Restore Sources window. Therefore, if you have made any
Restore Sources selections, they will be eliminated when you change backup servers.

Related Topics:
Change Backup Server Dialog



Change Backup Server Dialog
Your workstation may be attached to multiple backup servers.    This command enables you to choose a 
different backup server for Backup Exec processing.    Since you can also attach and detach from servers 
from here, you can administer an unlimited number of backup servers without having to exit, change your 
attachments around, and re-run Backup Exec.

This window is displayed when you choose Change Backup Server from the Admin menu, or click on the 
Change Backup Server icon on the Selection Bar. 

If no backup servers are found, you receive an informational message and the function ends.    If backup 
servers are available, a list of servers is displayed.    Choose one of these servers and press the OK 
button (you may also double-click on the server name).    Backup Exec detaches your workstation from 
the current server (if applicable) and attaches the workstation to the new server.

The grayed server icons indicate servers that you are not attached to.    This does not mean that you 
cannot change to them, it just means that you are not currently attached to them.    You can detach from a 
server by select a server name in the list and pressing the Detach button.    You will not be allowed to 
detach from a server if it is your current backup servers or if it is your primary server.

If you are not currently attached to the chosen server, you may be prompted for a user name and 
password.    If you have the password database enabled, it will use the user name and password stored 
there.    Disabling the password database will cause you to be prompted each time you change to a server
that you are not attached to.

If an error occurs, an error message is displayed.    Select a different backup server.

Note that information on screens may change if you change to a backup server on which you have 
different rights.    For example, if you are an administrator and change to a backup server on which you 
have only user privileges, some of the fields that displayed previously will not be available.

Changing backup servers redraws the Restore Sources window.    Therefore, if you have made any 
Restore Sources selections, they will be cleared when you change backup servers.



Deleting Cataloged Tapes (Administrator Only)
Backup Exec keeps track of the contents of tapes created during a backup or file grooming job. This 
information is maintained in a catalog, and is the basis for the information in the Restore Sources window.

Occasionally, you may need to remove a tape from the catalog. Perhaps the tape has been damaged or 
destroyed, or is no longer being used in Backup Exec operations.

To delete a tape from the catalog: 

1. Select Delete Cataloged Tapes from the Admin menu.    This function is available only to 
administrators.    This will open the Delete Cataloged Tapes dialog box.

This dialog lists all of the tapes currently existing in the catalog. 

2. To delete one or more tapes, highlight the tape name and click on the Delete button.      Backup 
Exec displays a confirmation dialog asking you to verify or cancel the deletion. 

3. You can select multiple tapes for deletion by holding down the mouse button and dragging it to 
highlight the appropriate tape names.

4. You may want to view the contents of a tape before deleting it.    To do so, use the Tapes Window.



Introduction
You access the configuration options through the Options menu.    These options determine the way the 
Backup Exec software works for you.    Your options are saved so that the next time you run Backup Exec,
the options that you select will still be active



General Options
The General Options menu contains Directory and File Processing, and Password Database options.

Related Topics:
Directory and File Processing
Password Database



Directory and File Processing
Process special files

Special files include files that are marked with any combination of "system", "read-only", and/or "hidden" 
attributes.    Special files should normally be backed up.    The default value is on.

If this option is unmarked, you can still back up special files by specifically checking their check boxes in 
the Directory Tree window when you create a backup job (as opposed to selecting an entire directory).

Process hidden files

These files are used by DOS, Windows, and some applications.    Hidden files do not appear when you 
view a directory through File Manager or through DOS' DIR command.    However, in the Backup Sources 
window, these files appear and are identified by a red exclamation point over the file icon.    

If this option is unmarked, you can still back up hidden files by specifically checking their check boxes in 
the Directory Tree window when you create a backup job (as opposed to selecting an entire directory).    
The default is off.

Process empty directories

Empty directories contain no files or subdirectories.    If you do not wish to back up or restore empty 
directories, unmark this option.    The default is on.

Many applications create directories that store temporary files.    Be careful when performing restore 
operations.    If the directory is deleted or outdated information is restored to it, the application may be 
harmed.



Password Database
Use password database

The password database is a list of user names and passwords used to log in to servers and attach to 
agent workstations.    If you mark this option, the passwords you enter to gain access to remote servers 
and workstations will be kept in a database so the next time you access the device the password will 
automatically be entered for you.    If you do not mark this option, you will be prompted to enter the 
password each time you access a device.    The contents of the password database are encrypted for 
security purposes.    The default is off.

Password protect database

Backup Exec enables you to add password protection to your password database.    This protects the 
password database against unauthorized access.    

To enter a password into the database:

1. Enter your user name and your password for the device you are accessing.    When you click on 
this button, the Enter Database Password dialog opens.

If the password database is enabled, the information you insert here will be added to the 
database and you will not be prompted for it again.    

2. If the device is not password protected, you still must press <Enter> or click on OK to close this 
dialog box and proceed.

To enter a password:

1. Enter a new password.

2. Enter it again for confirmation.    If your database is password protected, Backup Exec prompts 
you for the database password when you start the application.    

If you enter the correct password, the password database is opened for use during the session.    

If you enter an incorrect password, Backup Exec displays an error message and gives you 
another opportunity to enter a correct password.    

Unsuccessful attempt:

1. You have three chances to enter a correct password; if all three tries are unsuccessful, Backup 
Exec continues with the password database locked.    You cannot enable the password database 
or work with it in any way while it is locked.

2. You must restart the application using a correct database password to unlock the database.

Remove password protection

This option disables password protection.

To disable password protection:

1. If password protection is enabled, you can disable it by clicking on the Remove Password 
Protection button.    This opens the Enter Database Password dialog.    

2. Enter the database password.

3. Click OK to disable the password protection.





Backup Options
The Backup options control processing during backup operations.    This window is displayed when you 
choose Backup from the Options menu.

Related Topics:
Backup Options



Backup Options
Back up devices alphabetically

This option allows you to have Backup Exec back up drives you have selected in alphabetical order.    For 
example, if you selected devices Server_1\SYS: and Bill (in that order), and you want them to be included
in the backup set alphabetically (Bill and Server_1) select this option.    If this option is unmarked, devices 
are backed up in the order in which they were selected.    The default is on.

Verify after backup (default setting)

As each backup is submitted, you can select whether or not to verify the data backed up during that job.    
Verifying the tape ensures that no errors were encountered during the backup and that the data can be 
restored by Backup Exec.    When "Verify after backup" is marked, the "Verify after" field in the Submit 
window will automatically be turned on.    The default is on.

Scan Devices to estimate backup size (default setting)

This option determines the default value of the Scan Devices options.    As each job is submitted, the 
Scan Devices option can be changed for that job.    If this option is marked when the job is run, Backup 
Exec will scan the devices to be backed up to estimate the number of bytes to be processed.    Choosing 
this option for a job will slow down the backup process, but will enable you to monitor the percentage 
completed as the backup operation is running.

Related Topics:
Backup Options - Administrator



Backup Options - Administrator
The Administrator view of the Backup Options includes the following:

Skip open files

This option causes Backup Exec to skip any files that are open during backup without attempting to close 
them.    These files will not be included in the backup.    The default is on.

Wait for open files to close

This option causes Backup Exec to wait for open files to close before attempting their backup.    The time 
that the system will wait before attempting backup is set at the Backup Server level.    For example, the 
Administrator may determine that the system will wait five minutes for an open file to close before 
attempting to back up that file.

Back up files in use

This option causes Backup Exec to back up any files that are currently open and in use.    The file will not 
be available to the user while it is being backed up.



Restore Options
The Restore options control processing during restore operations.    This window is displayed when you 
choose Restore from the Options menu.

Restore over existing files

When this option is unmarked, files that appear only on the tape and not the device are restored.

Be careful of restoring older versions of files over existing files.    For example, after you have upgraded 
system files or a software package, you would not want to restore older versions of the files over the more
current versions.    

Unmarking this option causes the software to check for existing files, which slows down the restore 
operation.    If you are only restoring a few files and you are certain that the files are the versions you 
want, leave this option marked.

Restore security information (Administrators only)

Restore trustee information and inherited rights mask for files and directories.

Restore volume restrictions (Administrators only)

Restore volume restriction information.



Job History Options
Backup Exec keeps a record of all activity during a backup, restore, or file grooming session.    These 
options determine the way Backup Exec stores this information.    This option is not available if you are 
not connected to a backup server.

This window is displayed when you choose Job History from the Options menu.

Number of job history records to keep  

· Keep maximum records allowed by administrator:    At the Job Manager level, the system 
administrator determines the maximum number of job history records that a user can keep.    If 
you want to maintain the maximum number of records that your administrator has set, check this 
box.    If the number of job history records exceeds this number, your oldest job history records 
are automatically deleted.    To set up a different number of job history records to maintain, 
remove the check from this box.    If you are connected to multiple backup servers, you can 
maintain a different number of job history records at each server.

· Select number of records to keep:  You can decide to keep a different number of job history 
records from the number maintained by your administrator.    To do so, enter the number of job 
history records you want to keep.    Minimum value is 0, maximum value is 4095.    The server will 
maintain the number to identify up to the maximum allowed by the administrator (the field will 
show the number you select).    If you select a number lower than the number of job history 
records you currently have, the application deletes the excess records.    This field is grayed if you
elect to maintain the same number of records as your administrator.

Print

You can request that Backup Exec automatically send your job history logs to a print queue when your 
jobs complete.    Click on the Print button if you wish to set the job history print options.

Detail level for job history logs    

This option allows you to choose the level of detail for your Job History log files.    

Each successive level includes the previous level's output in addition to output of the selected level.    

· Level 0 turns the logging feature off.

· Level 1 includes a Novell network server/volume specification or Agent alias, the backup set 
number on the tape, the tape number, the tape label, the starting date and time, any errors 
encountered, ending date and time, and completion statistics.    This is the default setting.

· Level 2 includes level 1 plus a list of all processed subdirectories.    

· Level 3 includes levels 1 and 2 plus a listing of all the files processed.    

· Level 4 includes level 3 plus file sizes, file date/time and file attributes.

Related Topics:
Job History Print Log Options



Job History Print Log Options
You can have Backup Exec automatically print job history logs when your job completes (if the 
administrator has configured the Job Manager to allow this option).    The settings in the Print Job History 
Log dialog box apply to jobs submitted to the current backup server.    If you access a different backup 
server, you must re-configure the settings for each backup server that you choose.    Press <Enter> to 
activate the Print Job History Log options menu.    You can choose the following options:

Print when jobs complete successfully

Select this option if you want Backup Exec to print job history logs of jobs completing with a NORMAL 
status.

Print when jobs complete with errors

Select this option if you want Backup Exec to print job history logs of jobs completing with an ERROR or 
ABORTED status.

You will be required to supply the destination print server's name and print queue and your name and 
password.



Notify Options
E-mail Notification Dialog
Broadcast Notification Dialog



E-mail Notification Dialog
This dialog box enables you to determine whether E-mail will be sent to you when a job is completed.

The E-mail notification data is retrieved and stored on the active backup server you are currently logged 
into.    The e-mail database saves information by user ID.    Therefore, multiple users may have their own 
E-mail notification data on multiple backup servers.      A window displays whenever you select E-mail from
the Notify menu.

A window is displayed when you select E-mail from the Notify menu.

There are two options:

Email when job complete successfully

Choose this option if you want to be notified by E-mail when a job completes and has a status of 'Normal'.

Email when job complete with errors

Choose this option if you want to be notified by E-mail when a job completes and has a status of 'Error' or 
'Abort'.

For each option specify the following fields:

Notify Address

Specify the MHS address to notify.    See your administrator for details about setting up this address.

Include Job History

Choose whether the job history log is included with the e-mail message.

No validation is done on the Notify Address field.



Broadcast Notification Dialog
This dialog box enables you to control the ability of whether to broadcast message(s) when a job is 
completed.    The broadcast is sent out via the NetWare broadcast mechanism.    Any workstations which 
the user has logged into the Backup Server at the time the job completes will receive the broadcast 
message.

The broadcast notification flags are retrieved and stored on the active backup server you are currently 
logged into.    The database saves information by user id.    Therefore, multiple users may have their own 
broadcast notification flags on multiple backup servers. 

This window is displayed when you select    Broadcast from the Notify menu.

There are two options:

Broadcast when job complete successfully

Choose this option if you want to receive a broadcast message when a job completes and has a status of 
'Normal'.

Broadcast when job complete with errors

Choose this option if you want to receive a broadcast message when a job completes and has a status of 
'Error' or 'Abort'.



Display Options
These options determine whether certain Client Window elements are displayed on your screen.    You 
may wish to "toggle off" display of these elements to obtain more room within the window, then redisplay 
them as needed.

This window is displayed when you choose Display from the Options menu.

The Display options menu contains the following items:

Display Selection Bar

The Selection Bar is displayed across the top of your window when this option is selected.    The Selection
Bar contains buttons that allow quick access to Backup Exec functions.    The default is on.

Display Status bar

The Status Bar is displayed across the bottom of your window when this option is selected.    The Status 
Bar displays the current status of Backup Exec.    It also identifies your current backup server and user 
name.    The default is on.

Display Label bars

Label Bars are displayed across the top of the Backup Exec windows when this option is selected.    Each 
Label Bar provides column headings for the information in these windows.    As you use the scroll bar to 
move across the window, these column headings move with the appropriate data.    The default is on.

Display 3D

Determines whether the backup and restore sources windows display the currently selected item as 
highlighted or as a raised (3D) button.

Menu selections in title bar

When you move through the Backup Exec menus, the description of the current menu is always displayed
in the status bar.    Choose this option if you want this text displayed in the title bar at the top of the 
Backup Exec window as well.



Agent Options
Backup Exec has the ability to perform operations on remote workstations that are configured as Backup 
Exec agents.    The agent software enables backup and restore operations for these workstations through 
a Novell network.    The Agent Options enable you to determine whether agent functions are applicable for
this workstation.

This window is displayed when you choose Agent from the Options menu.

Enable Workstation Agent support

When this option marked, you will be able to select files and perform operations on DOS, Windows and 
OS/2 workstations running the Backup Exec Agent software.    



Technical Support Options
Backup Exec has the ability to operate in "technical support" mode.    Normally, you will enter this mode 
only when instructed to do so by a Technical Support representative.    In this mode, activities that occur at
the client workstation are logged for diagnostic use.    A Technical Support    representative will assist you 
in entering this mode if necessary.

If this mode is active, a Technical Support icon is displayed on your desktop.

Related Topics:
Technical Support Window
File



Technical Support Window
The Technical Support Window contains the following items:

Record to window

If this setting is marked, Backup Exec logs errors to an on-line window that can be viewed by double-
clicking on the Technical Support Window icon.

Record last [ ] messages

This setting determines the number of error messages retained in the Technical Support logs.    Enter the 
number of messages you want to keep in the box to the right of this field.

Record all messages

This setting causes Backup Exec to log all error messages occurring at this workstation.

Messages

Number of messages currently logged.

Reset Window

Clicking on this button erases all messages from the log and resets the message count to one.



File
Record to file

If this setting is marked, Backup Exec logs errors to a file stored within the workstation.    You can view 
this file by selecting Technical Support Logs from the Help menu.

File name

This option creates a name for the Technical Support file.    Include the full path name.

Messages

Number of messages currently logged.

Reset File

Clicking on this button erases all messages from the log and resets the error count.

Display Memory Trace

If this setting is marked, Backup Exec keeps track of actions within the application and reflects them in the
Technical Support logs to assist in troubleshooting.



Backup Strategies
With Backup Exec, you can decide which files to back up on your workstation and how often to back them
up.    This is called a backup strategy.    Included throughout the rest of this chapter are some helpful tips 
on creating a backup strategy for your data.

Related Topics:
Choosing a Backup Strategy
Full, Normal, Incremental and Differential Backups
Backup Strategy Examples



Choosing a Backup Strategy
In order to have a secure and effective data management plan, you must incorporate a strategy for 
backing up your data.

Several strategies are listed in this chapter.    Prior to choosing a strategy to use with the Backup Exec 
system, review the related topics shown below.

Related Topics:
How often should I back up?
How much data must be backed up?
Virus Protection
Which devices am I backing up?



How often should I back up?
While there is no absolute rule on how often to back up your data, there is one consideration that can help
you decide for yourself:

What is the cost of re-creating data that was added or modified since the last backup?

Calculate the manpower, lost time and/or sales, and other costs that would be incurred if your workstation
crashed right before the next backup was to take place (always assume the worst scenario).    If the cost 
is excessive, the strategy needs to be adjusted accordingly and you need to back up more often.

Ideally, you would want to do at least an Incremental or Differential backup every day.    A normal backup 
should always be performed before adding new applications or drastically changing your workstation's 
configuration.



How much data must be backed up?
This is a key determinant of the backup strategy you choose.    If you are backing up large amounts of 
data that needs to be retained for long periods of time, you will need to ask your network administrator 
how long tapes are kept before they are re-used.



Virus Protection
The threat of viruses is a reality.    Some viruses take effect immediately, while others take days or weeks 
to cause noticeable damage.    Because of this, you should have at least the following backups available 
to restore at any time:

· a one-week-old Full backup

· a one-month-old Full backup

Having these backups available should allow you to restore your workstation to the point it was before it 
became infected.



Which devices am I backing up?
Since Backup Exec can back up servers, client workstations and agents, this needs to be considered 
when choosing backup strategies.    If you are responsible for backing up devices other than your 
workstation, you will need to coordinate strategies with the users of those workstations.    For example, 
when and how often they want their systems backed up.    



Full, Normal, Incremental and Differential Backups
When you submit a backup, one of your options is selecting how Backup Exec will process the data you 
selected.    Full backups include all files and directories on your hard drive; Normal backups include 
selected files; Incremental backups include only the files that have changed since the last Normal or 
Incremental backup.    Differential backups include backing up all files modified since the last Normal 
backup.    

Before you can develop a backup strategy, you will need to decide whether you want to do only Full 
backups, or Incremental or Differential backups.    There are advantages and disadvantages to each 
method.

Related Topics:
Full Backups
Incremental Backups
Differential Backups



Full Backups
Advantages

Files are easy to find.    Since Full backups include all of the data you selected, you do not have to search 
through several catalog listings to find a file that you want to restore.

There is always a current backup of your entire system on one tape or tape set.    If you should need to 
restore your entire system, all of the most current information is located on the last backup.

Disadvantages

Redundant backups.    Since most of the files on your hard drive rarely change, each backup following the
first is merely a copy of what has already been backed up.

Full backups take longer to perform.    Full backups can be time consuming, especially when there are 
many other devices on the network that need to be backed up.



Incremental Backups
Advantages

Better use of media.    Only files that have changed since the last backup are included, so there is much 
less data storage space required.

Less time required for backup.    Incremental backups take much less time than Full backups to complete.

Disadvantages

Files are more difficult to find.    Files backed up incrementally can be spread across multiple tapes since 
the last Full backup.    To restore your entire system (in the event of a system crash) would require you to 
restore your last Full backup and all Incremental backups following it.



Differential Backups
Using a Full\Differential strategy is highly recommended.    Differential backups include backing up all files
modified since the last Full backup.    The difference between Differential and Incremental backups is that 
Incremental backups include only the files that have changed since the last Full or Incremental backup.

Advantages

Files are easy to find.    Restoring a system backed up under the Differential strategy requires restoring a 
maximum of only two catalog entries--the latest Full backup and the latest Differential backup.    This is 
less time-consuming than backup strategies that require the latest Full backup and all Incremental 
backups executed since the Full backup.

Less time required for backup.    Differential backups take less time to complete than Full backups.

Disadvantages

Redundant backups.        All of the files created or modified since the last Full backup are included on each
tape; thus creating redundant backups.    



Backup Strategy Examples
Ultimately you will want to use a combination of Full and Differential or Incremental backups.

Before implementing a Differential or Incremental backup strategy a Full backup must be performed. 

Depending on how much data you are backing up and how often your data changes, you can select 
whether to use Incremental or Differential backups between Full backups.    For example, if you constantly
work on a few files that are not very large, you would want to use a Differential backups.    If you work on 
several large database files that change daily, your network administrator may prefer that you use 
Incremental backups to save time and storage space.

Whether you choose to do a Full backup once a week or more is up to you.



The Menu Bar
After you start Backup Exec for Windows, a Menu Bar is displayed across the top of your screen.



File Menu
Under the File Menu, you can print a report or log, choose your printer, and exit from the software.    Use 
the scroll bar to see any commands that are hidden from view.

Related Topics:
Print
Printer Setup
Exit



Print
Prints a Job History, Selection File, or Technical Support Log.    The Print command sends your selection 
to the currently selected Windows printer.    You can change the printer selection through the Printer Setup
menu option.



Printer Setup
This command displays a list of printers and options which can be selected.    Available options depend on
the capabilities of your printer.

Available options include:

Printer

Default Printer

When this option is selected, print jobs are directed to the printer that is configured as your default.    The 
name of your default printer is displayed under the field.

Specific Printer

When this option is selected, print jobs are directed to the printer that you specify.    Click on the arrow 
button to display a list of available printers from which you can select.

Orientation

Portrait

When this option is selected, printed output is taller than it is wide when you view the printed text upright.

Landscape

When this option is selected,    printed output is wider than it is tall when you view the printed text upright.

Paper

Size

Determines the size of the paper you are using.    The default paper size depends on the country selected 
through the Windows Control Panel.    If United States is selected, the default paper size is letter (8.5 by 
11 inches).    If a European country is selected, the default paper size is A4.    If you are using a different 
size of paper, you must change this setting.

Source

Specifies the tray or bin from which paper feeds to your printer, if you are using single sheets of paper.    If
your printer uses paper that feeds into it through a tractor feeder, select Tractor.    Some printers enable 
you to feed paper manually.



Exit
Exits the Backup Exec software and returns you to your Windows desktop.    When you exit, any options 
that you have changed during this session will automatically be saved for you and be active when you 
return to the application.



Tree Menu
Using the Tree Menu, you can control the level of directory information shown in the Directory Tree 
window.    Use the scroll bar to see any commands that are hidden from view.

Related Topics:
Expand One Level
Expand Branch
Expand All
Collapse Branch



Expand One Level
Allows you to display the directory one level below the currently selected directory.    You can also expand 
a directory by double clicking the mouse on a directory icon containing a plus sign.

To expand one level:

1. Click on the directory you want to expand.

2. From the Tree Menu, choose Expand One Level.



Expand Branch
Allows you to display the entire directory tree below the currently selected directory.

To expand a branch:

1. Click on the directory you want to expand.

2. From the Tree Menu, choose Expand Branch.



Expand All
Allows you to display the entire directory tree of the device displayed in the active window (all 
subdirectories will be visible).

To expand all:

1. Click on the directory you want to expand.

2. From the Tree Menu, choose Expand All.



Collapse Branch
Removes the directory tree of the currently selected directory from the Directory Tree window.    In the 
Backup Source and Restore Sources windows, you can use this command to collapse branches up to the
Agent level (Backup Exec Agent or NetWare Agent).

NOTE:  You cannot collapse either the root (Networks) or the Agent category items.

To collapse a directory level:

1. Click on the directory you want to close.

2. Click on Tree in the Menu bar.

3. Click on Collapse Branch.

Shortcut:  Double-click on the directory that you want to collapse.



View Menu
Allows you to change file and directory views in the Directory Tree window.    Use the scroll bar to see any
commands that are hidden from view.

Related Topics:
Tree and Directory
Tree Only
Directory Only
Split
All File Details
Selection Bar
Status Bar
Label Bar
Font



Tree and Directory
This command is active only when you are in a Directory Tree window.    It changes the active Directory 
Tree window to display two list box windows:    the left window displays the Directory Tree and the right 
window displays the File List



Tree Only
This command is active only when you are in a Directory Tree window.    It changes the active Directory 
Tree window to show only the Directory Tree.    Items in the directory are not displayed.



Directory Only
This command is active only when you are in a Directory Tree window.    The tree is not displayed.    It 
changes the active Directory Tree window to show only the active directory.



Split
This command is active only when you are in a Directory Tree window.    It allows you to adjust the 
position of the divider bar in the Directory Tree window.    Use your mouse or the left and right arrow keys 
to move the split bar left or right in the window.    Press <Enter> or the left mouse button to position the 
divider bar at the new location.



All File Details
This command is active only when you are in a Directory Tree window.    It changes the File List to display
the name, size, modified date, modified time, and attributes of the files and subdirectories in the active 
directory.    Possible attributes are:

A - Archive.  This attribute indicates that this file has been modified
since it was last backed up.

R - Read Only.

H - Hidden.    You will not see this file if you display a directory listing through DOS.

S - System.  This is an operating system file.

AFP - Apple file system file.

I - In use.



Selection Bar
Toggles the display of the Selection Bar at the top of your screen on and off.



Status Bar
Toggles the display of the Status Bar at the bottom of your screen on and off.



Label Bar
Toggles the display of the Label Bars providing column headings for the various Backup Exec windows on
and off.



Font
This dialog box enables you to view and change the fonts used for characters in the Directory Tree 
windows, Backup Sources window and Restore Sources window, and Tapes window. 

This window is displayed when you select Font from the View menu.

Related Topics:
Font
Font Style
Size
Sample



Font
Specifies the typeface you want to use.    The fonts available to you depend on those you have installed 
through Windows.    The font you are currently using is highlighted.



Font Style
Specifies the style options you want to use (i.e., bold, italic, or regular).    Available font styles depend on 
the font you choose.



Size
Specifies the point size for the fonts; the larger the point size, the larger the character appears on your 
screen.    Available sizes depend on the font you choose.



Sample
This box shows a sample of your selected font.    As you make changes to fonts, font style, or size, the 
sample in this box changes to reflect the new selections.



Admin Menu
The Admin Menu enables you to use functions that monitor and administer Backup Exec operations.    
Use the scroll bar to see any commands hidden from view. 

Related Topics:
Display Info
Catalog Search
Delete Cataloged Tapes (Administrator only)
Change Backup Server
Tape Rotation Tasks (Administrator only)
Job Manager Monitor (Administrator only)



Display Info
This option is only available if you have selected an individual file from the Directory Tree Window.    It 
displays the backup history for an individual file selected from the Directory Tree window, enabling you to 
select a specific version of the file with which to work.



Catalog Search
This menu option is available only if your workstation is attached to a backup server that has catalogs.    
Searches the catalog(s) of one or more fully-cataloged tapes for directories and/or file specifications.

The Enter Search Criteria dialog includes two text entry boxes:

1. Path.    Any files beneath the path are candidates for the search.    Therefore, if you identify "\" as 
the path, all directories will be searched. If you use "\WINDOWS", only files that are within the \
WINDOWS directory (or its subdirectories) will be searched.    Note that wildcards are not valid in 
the path name.

2. File.    This identifies a pattern for a file name.    Wildcards are acceptable in the file name.

To search catalogs for Files or Directories:

1. Click the Catalog Search button on the Selection Bar.    The Search Criteria window will open.    

2. Enter the search criteria (tape, path, and/or file name).    (When specifying the file name, 
wildcards may be used).    

3. You can also launch a search by choosing Catalog Search from the Admin Menu.



Delete Cataloged Tapes (Administrator only) 
This menu option is available only if your workstation is attached to a backup server that has catalogs.    It 
causes the Delete Cataloged Tapes Window to display.    This window contains a list of all cataloged tapes
and enables you to delete unused catalogs as necessary.    This capability can substantially increase your
free disk space.

This menu option is available only to users with administrator privileges; if you are not an administrator, it 
does not appear on your menu.

Note:    Once you delete a catalog, the only way to retrieve it is to re-catalog the tape at the backup server
level.

The catalog list is automatically updated periodically to remain current with any additions or deletions 
made to the catalogs on the backup server, including those made from another workstation.

To delete one or more tapes:

1. Highlight the tape name(s).

2. Click on the DELETE button.    Backup Exec prompts you to confirm the deletion.



Change Backup Server
Your workstation may be attached to multiple backup servers.    Using the Change Backup Server option, 
you can choose which backup server you wish to use in performing operations.

1. From the Admin menu, choose Change Backup Server.

2. A dialog box displays a list of the backup servers to which you are attached.

3. Double-click on the name of the backup server you want.

Shortcut:  Double-click on the Change Backup Server button on the Selection Bar. 

NOTE:    It is recommended that you complete all of your server attachments prior to entering Windows.    
Should you need to attach to another server, exit the application and Windows, attach to the server, then 
re-enter Windows and the application.



Tape Rotation Tasks (Administrator only)
The Tape Rotation Tasks window includes functions that need to be performed before a tape rotation job 
can take place (e.g., prepare tapes, etc.).    This window is only available when tape rotation is enabled at 
the current backup server.



Job Manager Monitor (Administrator only)
The Job Manager Monitor allows you to view activity occurring at the Job Manager from a workstation 
running the client software.    This function can also be accessed through the Job Schedule window.



Select Menu
The Select Menu contains functions used for file selection.

Use the scroll bar to see any commands that are hidden from view.

Related Topics:
Check
Uncheck
Advanced
Uncheck All
Include Subdirectories
Save Selections
Use Selections
Delete Selections
View Selections
Selection Types (Administrator only)
Clearing Selections



Check
This option is available in any window that contains elements with check boxes.    Places a check mark in 
the check box of highlighted selections.    This command is used to select items for backup or restore.



Uncheck
This option is available in any window that contains elements with check boxes.    Removes a check mark 
from the check box of highlighted selections.    This command is used to de-select items for backup or 
restore.



Advanced
This option displays a dialog that provides an easy way to choose groups of directories and/or files for 
Backup Exec operations.    According to the operation under way, Backup Exec either displays the 
Advanced File Selection - Backup or the Advanced File Selection - Restore window.



Uncheck All
This option removes all check marks (even from items not selected) in all windows.



Include Subdirectories
This option determines whether any file search is limited to the specified path, or if it includes all 
subdirectories when selecting a drive or directory.



Save Selections
This option is available when at least one backup source selection exists.    This option saves the current 
list of file selections in a user-specified file.



Use Selections
This option is available when at least one set of selections has been saved.    This command displays a 
list of selection files that can be used in Backup Exec operations.    You can retrieve these selections and 
use them to process another job.



Delete Selections
This option is available when at least one set of selections has been saved.    This command removes 
selection files from the Use Selections list.



View Selections
This dialog box displays a list of current selections available for your review.    To view the selections that 
have been saved, highlight the selection file name and click on the VIEW button.    You can only view the 
selections; you cannot edit them through this command.    

This window is displayed when you choose View Selections from the Select menu.

NOTE:    You can only view the selections; you cannot edit them through this command.



Selection Types (Administrator only)
Backup
Tape Rotation
Selection Files



Backup
These are selections used for backup and file grooming jobs.    They are stored in the Backup Exec 
subdirectory on the workstation.



Tape Rotation
These are selections used for tape rotation jobs.    They are stored in the tape rotation path on the 
configured backup server.



Selection Files
Displays a list of existing selections.    Click on the selection to be viewed.    A window will then be 
displayed listing the contents of the selection file.    For administrators, the selection files listed will differ 
between the two selection types.



Clearing Selections
Selections can be cleared in four ways:

· Click on the check mark in the check box

· Click on the Uncheck button

· Click on Select in the Menu bar and click on Uncheck

· Click on Select in the Menu bar and click on Uncheck All

Uncheck All will clear all selections in all windows.



Job Menu
Allows you to submit and monitor jobs.

Related Topics:
Submit Backup
Submit Restore
Submit File Grooming (Administrator only)
Submit Tape Rotation (Administrator only)
View Schedule
View History
View Tape Rotation (Admin Only)



Submit Backup
Select this item to schedule and submit a backup operation.



Submit Restore
Select this item to schedule and submit a restore operation.



Submit File Grooming (Administrator only) 
Select this item to schedule and submit a file grooming operation.



Submit Tape Rotation (Administrator only) 
Select this item to schedule and submit a tape rotation operation.



View Schedule
Displays a list of jobs that are scheduled to process.    Using this option, you can check the status of a 
job's processing, place jobs on hold, activate jobs on hold, and delete jobs.



View History
Displays the results of jobs that have previously processed and enables you to view detailed history 
information or delete records.



View Tape Rotation (Admin Only)
Displays the current tape rotation jobs and allows you to edit, or delete the job(s).    You can also view the 
job's run histories.



Options Menu
This menu allows you to custom configure the Backup Exec software for your workstation.    The defaults 
are shown in [ ].    Use the scroll bar to see any commands that are hidden from view.

Related Topics:
General
Backup
Backup (Administrator only)
Restore
Job History
Notify
Display
Agent
Technical Support



General
Enables you to set the following miscellaneous controls that apply to all operations:

· Process Special Files [YES]

· Process Hidden Files [YES]

· Process Empty Directories [YES]

· Use Password Database [YES]



Backup
Enables you to set the following default backup options:

· Back Up Devices Alphabetically [YES]

· Verify After Backup [YES]



Backup (Administrator only)
· Skip Open Files [YES]

· Wait For Open Files to Close [NO]

· Back Up Open Files In Use [NO]



Restore
Enables you to set the following default restore options:

· Restore over existing files [YES]



Job History
Backup Exec keeps a record of all activity during a backup, restore, or file grooming session.    This option
enables you to set the following job history storage options which determine the way Backup Exec stores 
the information:

· Keep maximum records allowed by administrator

· Select number of records to keep [4095]

· Detail level for job history logs [Level One - Backup set information]



Notify
This item allows you to configure how you are to be notified when a job completes or an error occurs.



Display
These options determine whether certain Client Window elements are displayed on your screen by setting
the following default display options:

· Display Selection Bar [YES]

· Display Status Bar [YES]

· Display Label Bars [YES]



Agent
Backup Exec has the ability to perform operations on remote workstations that are configured as Backup 
Exec Agents.    The agent software enables backup and restore operations for these workstations through 
a Novell network.    These options allow you to enable or disable agent workstation support and functions.

· [Enabled]



Technical Support
Enables you to set options that control the way error information is stored for technical support purposes.  
This option is displayed only when you are running the Windows Client in "technical support" mode, as 
instructed by a support representative.



Window Menu
Allows you to set the method used to display your windows.    Includes a drop-down menu of the open and
minimized windows.    Selecting a window from the list will make it the current window.    Use the scroll bar 
to see any commands hidden from view.

Related Topics:
Cascade
Tile
Arrange Icons
Refresh
Close All



Cascade
Rearranges the open windows so that they all overlap, leaving the title bar of each window visible.

To cascade windows: 

1. Click on Window in the Menu bar.

2. Click on Cascade.



Tile
Tiling resizes open group windows and places them side by side so that each window is visible.    

To tile windows:

1. Click on Window in the Menu bar.

2. Click on Tile.



Arrange Icons
Aligns all minimized window icons on the display.



Refresh
The "Refresh" command enables you to update the current window (Backup Sources, Restore Sources, 
or Tapes Window).    Refreshing the Backup Sources window enables you to see new agents that may 
have become active since you started the application (or since your last Refresh).    Refreshing the 
Restore Sources or Tapes Window enables you to update your view of the catalogs.    If a backup just 
occurred, you must refresh the Restore Sources window in order to see the new backup.

Note that refreshing either the Restore Sources or Tapes Window refreshes both of them.    Any 
selections made in the Restore Sources window are lost when you perform a refresh; the application 
displays a confirmation dialog to remind you of this.

To update a window, choose Refresh from the Window menu.



Close All
Closes all but the application window.    Backup Sources, Restore Sources, and Tapes windows will be 
minimized.



Help Menu
Accesses the on-line help facility.    Use the scroll bar to see any commands hidden from view.

Contents

Lists the available help topics.

Search For Help On

Allows you to locate help information by keyword.

How to Use Help

Provides a tutorial on how to use the help feature.

Technical Support Logs

Backup Exec can track and log errors that occur at either the backup server or client level.    These logs 
contain information that is helpful to technical support in troubleshooting.

To display the Technical Support Logs:

1. From the Help Menu, choose Technical Support Logs.

2. If you want to view backup server errors, choose Server Support Log.

3. If you want to view client server errors, choose Client Support Log.

If no logs exist, or if a log is in use by another user, Backup Exec displays a message and the function 
ends.    Otherwise, the log is displayed for your review.    Use the scroll bars to view all of the log.

About Backup Exec

Displays information regarding this specific version of the product.



The Selection Bar
The Selection Bar is displayed under the Menu Bar across the top of the screen.    The Selection Bar 
contains "buttons" you click on as shortcuts to the following operations:

Backup Starts the backup operation.
Restore Starts the restore operation.
File Grooming Starts the file grooming operation.
Catalog Search Launches a search for a specific file or set of files to restore.
Change Backup Server Enables you to change from your  current Backup Server to another    

server.
 Check Places a check mark in the check box(es) of    highlighted selections.

Uncheck Removes the check mark from    the check box(es) of highlighted 
selections.

Adv.    Selection Allows you to quickly choose groups of files for Backup Exec 
advanced operations.

Job Schedule Displays a list of jobs that are scheduled to process.
Job History Displays the results of jobs that have previously processed.
Exit Lets you exit the Backup Exec Windows Client software.



Backup/Restore Sources Window Bitmaps
Active Network Agent
Inactive Network Agent
Agent Type
Backup Exec DOS Agent
Backup Exec Macintosh Agent
Backup Exec NT Agent
Backup Exec OS/2 Agent
Backup Exec UNIX Agent
Backup Exec Windows 95 Agent

{bmc OBJECT.BMP} Volume
{bmc SERVICE.BMP} Novell SMS Service

Workstation
Tapes Window Bitmaps

Tape
Multiple Tapes



Directory Tree Bitmaps
Fully Cataloged Backup Set
Backup Set with No File History
Corrupt File
Executable File
File
Directory (No Subdirectories)
Directory with Subdirectories Displayed
Directory Containing Subdirectories
Expanded Directory, All Subdirectories Displayed
Expanded Directory, No Subdirectories
Expanded Directory With Additional Subdirectories
Directory, Subdirectories Expanded,    Corrupted
Directory, No Subdirectories, Corrupted
Directory, Containing Subdirectories, Containing Corrupt File(s)
Directory Containing No Files, Expanded, Corrupted
Directory Containing No Subdirectories or Files, Corrupted
Directory Containing No Files, Corrupted
Directory Containing No Files, Expanded
Directory Containing No Files
Directories Containing No Files, Corrupted, All Subdirectories Expanded in Right Window
Directory Containing No Subdirectories or Files, Corrupted
Directory Containing No Files, Corrupted, Selected Subdirectories Expanded in Right Window
Directory Containing No Files, All Subdirectories Expanded in Right Window
Directory Containing No Subdirectories or Files, Expanded in Right Window
Directory Containing No Files, Selected Subdirectories Expanded in Right Window
Directory Containing No Files, Subdirectories Displayed in Left Window
Directory Expanded in Right Window, Contains Corrupt Files
Directory Expanded in Right Window, No Subdirectories, Contains Corrupt Files
Directory Expanded in Right Window, Contains Additional Subdirectories, 

Contains Corrupt Files
Hidden Corrupt File
Hidden Executable File
Hidden File
Previous Directory



Selection Bitmaps
Fully Selected
Not Selected
Partially Selected



Icons
Icons are used to identify Backup Exec functions within your Program Manager window and within your 
Windows Client desktop.    These icons are displayed when you minimize a Backup Exec function window.

Agent Functions

            Backup Exec Icon

Backup Operations

Catalog Search Window

Directories Window

Directory Tree Window

Files Window

Job History Window

Restore Operations

Tapes Window

Technical Support Window

Use Selections Window



Cursor Movement Keys
Key(s) Function

Direction key Moves the cursor left, right, up, or down in a field.

End or Ctrl+ Moves to the end of a field.
Right Arrow

Home or Ctrl+ Moves to the beginning of a field.
Left Arrow

Page up or Moves up/down in a field, one screen at a time.
Page Down



Dialog Box Keys
Key(s) Function

Tab Moves from field to field (left to right and top to bottom).

Shift+Tab Moves from field to field in reverse order.

Alt+letter Moves to the option or group whose underlined letter 
matches
 the one you type.

Direction key Moves from option to option within a group of options.

Enter Executes a command button.    Or, chooses the selected item
in

a list box and executes the command.

Esc Closes a dialog box without completing the command.
(Same as Cancel)

Alt+Down Opens a drop-down list box.
Arrow

Alt+Up/Down Selects item in a drop-down list box.
Arrow

Spacebar Cancels a selection in a list box.
                                            Selects or clears a check box.

Ctrl+Slash Selects all the items in a list box.

Ctrl+Backslash Cancels all selections except the current selection.

Shift+ Extends selection in a text box.
Direction key

Shift+Home Extends selection to first character in a text box.

Shift+End Extends selection to last character in a text box



Editing Keys
Key(s) Function

Backspace Deletes the character to the left of the cursor.
Or, deletes selected text.

Delete Deletes the character to the right of the cursor.
                                Or, deletes selected text.



Help Keys
Key(s) Function

F1 Gets Help and displays a Help topic on the
 selected command, dialog box option, or system
 message.

Shift+F1 Gets Help and displays the Help index.



Menu Keys
Key(s) Function

Alt Selects the first menu on the menu bar.

Letter key Chooses the menu, or menu item, whose
 underlined letter matches the one you type.

Alt+letter Pulls down the menu whose underlined letter
Key matches the one you type.

Left/Right Moves among menus.
Arrow

Up/Down Moves among menu items.
Arrow

Enter Chooses the selected menu item.

ESC Backs up one selection; e.g., if a sub-menu is
displayed, ESC will return you to the main
menu.



System Keys
The following keys can be used from any window, regardless of the application you are using.

Key(s) Function

Ctrl+Esc Switches to the Task List.

Alt+Esc Switches to the next application window or
minimized icon, including full-screen programs.

Alt+Tab Switches to the next application window,
 restoring applications that are running as icons.

PrtSc Copies the entire screen to Clipboard.

Alt+PrtSc Copies the active window to Clipboard.

Alt+F4 Closes the active window.

F1 Gets Help and displays the Help Index for the
 application or specific help for a command,

dialog box, or window. 



Text Selection Keys
Key(s) Function

Shift+Left Selects text one character at a time to the left or 
or Right Arrow right.

Shift+Down Selects one line of text up or down.
or Up

Shift+End Selects text to the end of the line.

Shift+Home Selects text to the beginning of the line.

Shift+ Selects text down one window.
PageDown Or, cancels the selection if the next window is

already selected.

Shift+Page Up Selects text up one window.
Or, cancels the selection if the previous window

 is already selected.

Ctrl+Shift+Left Selects text to the next or previous word.
or Right Arrow

Ctrl+Shift Up Selects text to the beginning (Up Arrow) or end 
(Down Arrow) or of the paragraph.
Down Arrow            

Ctrl+Shift+End Selects text to the end of the document.

Ctrl+Shift+Home Selects text to the beginning of the document.



Window Keys
Key(s) Function

Alt+Spacebar Opens the Control menu for an application
 window.

Alt+Hyphen Opens the Control menu for a document
 window.

Alt+F4 Closes a window.

Alt+Esc Switches to the next application window or
minimized icon, including full-screen programs.

Alt+Tab Switches to the next application window,
restoring applications that are running as icons.

Alt+Enter Switches a non-Windows application between
running in a window and running full screen.

Direction key Moves a window when you have chosen Move
 from the Control menu.    Or, changes the size of
 a window when you have chosen Size from the

Control menu.



General
The Main Agent Publisher Index is a Backup Exec module which runs on a workstation.    It allows you to 
configure an agent.

Backup Exec Agent

Backup Exec supports remote workstations running the Backup Exec Agent software and transport 
protocol appropriate for the platform.

The protocol used for Windows is Sequenced Packet eXchange (SPX). 

Client

The client module interfaces with the Backup Exec Job Manager and Backup Exec Agents.    You are 
currently running the Windows or OS/2 client.    The client module is used to: to submit jobs, check the 
status of your jobs, review job results, and perform other administrative functions.

Agent

This module interfaces with the remote peer-to-peer driver to support backup/restore operations for the 
agent workstation.    The workstation communicates with the Job Manager via this module or through a 
Novell Target Service Agent (TSA). 

(Note that TSAs do not exist for NetWare 286 servers.) 

Publish Definition

Workstations running the Backup Exec Agent software can be configured using the Agent Publisher.    
When an agent is published, the Backup Exec client software can recognize the workstation on the 
network.    Only workstations with published agents appear in the Backup Sources window.    



Fields
Workstation Name Field

Enter the name by which your workstation will be known.    A maximum of 36 alphanumeric characters is 
permitted.    This field is not case sensitive; i.e., you can use upper or lower case characters.

Use a name that is meaningful. (e.g. the user's last name).

Password Protect Field

You can prevent unauthorized access to a workstation or published drive by protecting it with a password. 

Leave the check box blank [ ] to prevent this drive or workstation from being password protected when the
Agent is loaded into memory.

Check the check box [X] to assign a password.    This will cause a dialog box to be displayed prompting 
you to enter the password and verify it.

Publish Field

The Publish box works in conjunction with the Path boxes.    By activating a Publish box with a mouse 
click (an X appears in the box when it is activated), the published path enables the Backup Exec client 
software to recognize the workstation on the network.    Other workstation clients, regardless of the 
platform, can submit jobs from published workstation agents to the Job Manager.

Leave the check box blank [ ] to prevent this drive from being published when the Agent is loaded into 
memory.

Check the check box [X] to re-publish this drive at a later date.

Make sure that you reboot your machine if you modify this field.    This allows the changes to take 
effect.      

Path Field

A path identifies the device you want to publish.      For example,    if you want to publish your entire C: 
volume, the path would be "C:\".

You can also publish a specific directory.    For example, to publish your C:\APPS directory, enter    "C:\
APPS"    for a path.

Alias Field

An alias is the name that a user from another workstation will use to identify this published path.    A 
maximum of 128 alphanumeric characters is permitted.    This field is not case sensitive; i.e., you can use 
upper or lower case characters.

Use a name that is pertinent to the path.    For instance, if you publish your C:\ directory, use an alias such
as "Drive-C".

Password Field

You can prevent unauthorized access by protecting this workstation or published drive with a password.    
Enter the desired password here.    A maximum of 128 alphanumeric characters is permitted.    This field is
not case sensitive; i.e., you can use upper or lower case characters.

Asterisks will be displayed instead of the actual characters.    



After the password has been entered, you will need to confirm that it is correct by typing it again in the 
Confirm Password Field.

Confirm Password Field

Enter the password again to ensure that the password was entered correctly. If the password you type 
does not match the first one,    an error message will be displayed and the password will not be changed.

Backup Only Field

Check the check box [X] to publish this drive for backup purposes only.    If the drive is published for 
backup purposes only, a restore from a Client will NOT be permitted.

Leave the check box blank [ ] to allow all operations on this drive.

(WARNING:    The modified bit will be cleared regardless of the setting of this field if the Backup 
Exec software performing the backup is configured to do so.)



Boxes
Drives List Box

This list box displays all DOS and NetWare drives that you are mapped to.

By selecting a drive from this box, you will be able to select any of its directories or subdirectories and 
ADD it to your next empty path field.

Directories List Box

This list box displays all directories that are related to the drive shown in the Drives list box.

By selecting a directory from this box, you will be able to ADD to your next empty path field.



Buttons
Browse Button

This button will take you to the Select Path dialog box where you can select any drive and directory that 
your workstation is mapped to.

Exit Button

This button will allow you to exit the application.    If you have not saved your data, the system prompts 
you to save before exiting.



General
This topic contains error messages that you might see while running the Windows Client, and possible 
solutions to correct the problem.    If the solution provided does not solve your problem or you cannot find 
a message in this appendix, contact the dealer from which you purchased this product. 



SMDRINCL.DAT File
The SMDRINCL.DAT file allows you to specify the file servers (SMDRs) that appear in the Source 
window.    This file can be created with a text editor (e.g., DOS' EDIT or Windows' Notepad).    This file is 
useful in cases where you only want to perform operations on certain server volumes or if there are 
problems with a certain SMDR.

If you wish to temporarily exclude a device that is contained in the SMDRINCL.DAT file, place a "#" in 
front of it.    For example, if you wanted to temporarily remove SERVER_3 from the list of servers that 
appear in Backup Exec, the entry in the file would be #SERVER_3.

You can use the wildcard character "*" in the SMDRINCL.DAT file to indicate multiple servers.    For 
example, TEST* would include all servers beginning with the name "TEST" (e.g., TEST_1, TEST_2, etc.). 
The wildcard can only be placed at the beginning or the end of the text string (e.g., *TEST or TEST*).

The location of the SMDRINCL.DAT file is very important.    The following table shows where the file 
should be located for each Backup Exec module:

Backup Exec Module Location of the SMDRINCL.DAT file

Job Manager and NetWare client SYS: BKUPEXEC

DOS client C:\BKUPEXEC\DOS_WS (default)

Windows client C:\BKUPEXEC\WIN_WS\WIN31 (default)

If a SMDRINCL.DAT file exists on the backup server, it will override the SMDRINCL.DAT on the 
workstation.



Error Message Table
Catalog Errors
File Errors
Hardware Errors
Help Errors
Job Errors
Memory Errors
Network Errors
Password Database Errors
Printing Errors
Resource File Errors
Selection File Errors
Backup Exec Errors



Catalog Errors
This topic contains information concerning errors about catalogs.

Related Topics:
Error initializing the catalogs.
Error opening a file.
Error positioning in a file.
Error reading a file.
Not enough available file handles.
Unable to use the catalog path specified in the Backup Server configuration file.    Catalogs will not be 
available.
Unable to open the catalog file.
Unknown error.



Error initializing the catalogs.
Backup Exec could not initialize the catalogs because:

· The catalog path specified in the Backup Server's configuration file does not exist.

Make sure the catalog path specified in the configuration file exists.

· You have insufficient rights to the catalog path.

Make sure that you have Read and Scan rights to the catalog directory, and that you have 
Read rights for every file that you have Scan rights for.

· The catalog files have become corrupted.

Restore the catalogs from the last backup that was made of them.



Error opening a file.
The client could not open a catalog file because:

· The user does not have appropriate rights to the file.

Make sure that the user has Read rights to all the files for which he or she has Scan rights.

· The Backup Server is down.

Exit the client and try the operation again when the Backup Server is available.



Error positioning in a file.
There was an error positioning to an entry in the catalogs because:

· The catalog file is corrupt.

Use the Job Manager to recatalog the tape corresponding to the catalog file.

· The Backup Server is down.

Exit the client and try the operation again when the Backup Server is available.



Error reading a file.
One of the catalog files could not be read because:

· The file is corrupt.

Use the Job Manager to recatalog the tape corresponding to the catalog file.

· The user does not have sufficient rights to the file.

Make sure that the user has Read rights to all the files for which he or she has Scan rights.

· The Backup Server is down.

Exit the client and try the operation again when the Backup Server is available.



Not enough available file handles.
· A catalog file could not be opened because all file handles are currently in use.

Change your CONFIG.SYS to specify at least FILES=40.



Unable to use the catalog path specified in the Backup Server configuration file.    
Catalogs will not be available.

· The catalog path specified in the Backup Server's configuration file could not be accessed.    
Either the directory does not exist or the user does not have sufficient rights to it.

Ensure that the catalog path specified in the Backup Server configuration file is correct and
that the catalog path exists.    Then, ensure that you have Read and Scan rights to the 
catalog directory.    Refer to the Administration Manual for more information about the 
configuration file.



Unable to open the catalog file.
One of the catalog files could not be read because:

· The file is corrupt.

Use the Job Manager to recatalog the tape corresponding to the catalog file.

· The user does not have sufficient rights to the file.

Make sure that the user has Read rights to all the files for which he or she has Scan rights.

· The Backup Server is down.

Exit the client and try the operation again when the Backup Server is available.



Unknown error.
An unexpected error has occurred while trying to access the catalog files.    Probable reasons are:

· The catalog file is being accessed by another user.

Try the operation again.    If another user is accessing the catalog, the error should 
disappear after a few moments.

· The catalog file was deleted after the client located it.

Use the Job Manager to recatalog the tape corresponding to the file.



File Errors
Cannot close the file <filename>.
Cannot open the file <filename>.
Cannot open the file <filename>.    The file is currently in use.
Log file path\BEWINDBG.LOG or \BEMGRDBG.LOG does not exist.



Cannot close the file <filename>.
· A file that was previously opened by the client cannot be closed.    This is probably caused by 

memory corruption.

Exit the client and try the operation again.    If the problem persists, contact Technical 
Support.



Cannot open the file <filename>.
The file <filename> cannot be opened because:

· The user does not have sufficient rights.

Make sure that the user has rights to the file.

· All available file handles have been used.

Make sure that FILES is set to at least 40 in your CONFIG.SYS.

· The file has been corrupted.

If this error is received on a selection file, recreate the selection file under a new name.    If 
the message is received when trying to view a technical support log, it is not an error.    
Technical support logs can be created only by Technical Support.



Cannot open the file <filename>.    The file is currently in use.
· The file <filename> is currently in use by the Job Manager.

Wait until the Job Manager closes the file.    The Job Manager's technical support file 
BEMGRDBG.LOG remains in use as long as Job Manager is running.    To view this file 
from the Windows Client, you will need to exit the Job Manager.



Log file path\BEWINDBG.LOG or \BEMGRDBG.LOG does not exist.
· The Technical Support log file for the Client or Backup Server software does not exist.

None.    These files are created in order to assist Technical Support in diagnosing errors.    

Unless you have encountered a severe error that required the assistance of Technical 
Support, you will receive this message if you try to view these files.



Hardware Errors
Device <device_name> does not exist.
Drive not responding.
General failure on device <device_name>.



Device <device_name> does not exist.
· Backup Exec has tried to access a device that does not exist.    The device is probably down.

Try the operation again when the device becomes available.



Drive not responding.
· Backup Exec is trying to communicate with a drive that is not responding.    The drive is probably 

down or the agent is locked.

Try the operation again when the device becomes available.



General failure on device <device_name>.
· Backup Exec is trying to communicate with a drive that has experienced an error.    The drive or 

its agent is probably down.

Try the operation again when the device becomes available.



Help Errors

Help file BEWIN.HLP was not found.
· The file containing the help text could not be found in the directory where the Backup Exec 

Windows Client is installed.

Reinstall the Backup Exec Windows Client software.



Job Errors
Does not support File Grooming.    It will not be included.
Has nothing to back up.    It will not be included.
Error # reading summary file for user <user_name>.
Summary file is in use.
There are no restore targets readily available.
There are not any available restore targets appropriate for backup set <set_name>.
There was an error submitting a job to Backup Server <server_name>.
Unable to read log file <file_name>.
Unable to use the log path in the Backup Server configuration file.



Does not support File Grooming.    It will not be included.
· File Grooming may only be performed on devices whose operating system maintains a last 

access date.    <Device_name> is part of a system running DOS or some other operating system 
that does not support last access date.

Select a device that supports last access date.



Has nothing to back up.    It will not be included.
· <Device_name> is a Novell or Backup Exec agent that does not have any sub-devices to be 

backed up.    This is not an error.

None.



Error # reading summary file for user <user_name>.
An error occurred when trying to read the job history summary file for the user.    # is one of the following:

· Error 4105 - the file could not be found or the file could not be opened.

Ensure that the log file path specified in the Job Manager's configuration file is correct.    
Ensure that the file exists and the user has Read rights to the file.

· Error 4101 - the file may be corrupt or the Backup Server may be down.

Determine whether the Backup Server is down.    If it has, try the operation again when the 
server is available.    If the file is corrupt, restore it from the most recent backup containing 
it.



Summary file is in use.    
Job history information for user <user_name> is not available at this time.

· The Job Manager is currently servicing a job for <user_name> and has the summary file for that 
user open.

Wait until the Job Manager finishes servicing the user's job and try again.



There are no restore targets readily available.    
Connect to the desired target objects in the backup sources window and retry.

· You are only allowed to restore to devices that have supplied a user name and/or password (if 
needed).    This message means that you have not provided a user name and password for any 
device.    It may also mean that the device that you wish to restore is read-only (published as 
"backup only").

To provide a user name and password for a device, double click on its parent in the 
Backup Sources window.    Continue double-clicking on subsequent sub-devices until you 
are presented with a user name and password dialog.    The user name and password that 
you supply will remain active until you exit the application (or indefinitely if you have the 
password database enabled).    If the device is read-only, it must be republished to allow 
both backup and restore operations.



There are not any available restore targets appropriate for backup set 
<set_name>.    
You have not supplied a user name and password for any devices that are valid destinations for the given
backup set.    The rules for restoring backup sets are:

· NetWare 4.x Directory Services backup sets may only be restored to the Directory Services 
object from which the backup set was made.

NetWare 3.x bindery backup sets may only be restored to another NetWare 3.x bindery.

SMS object backup sets may only be restored to other SMS objects.

Backup Exec Agent backup sets may only be restored to a Backup Exec Agent that allows 
restore operations.

Select the appropriate type of device in the Backup Sources window and double click on it.    
Repeat this operation on the sub-devices as necessary until you are presented with a user 
name and password dialog.    The user name and password that you supply will remain 
active until you exit the application (or indefinitely if you have the password database 
enabled).



There was an error submitting a job to Backup Server <server_name>.
The Backup Exec Windows Client was unable to submit a job to the Backup Server because:

· The Backup Server is down.

Resubmit the job when the server is available.

· One of the devices that you have selected for backup has become unavailable.

Resubmit the job when the device becomes available.

· You have provided an incorrect password for one of the devices that you have selected for 
backup.

Ensure that the user name/password combination is correct for all devices you want to 
back up.

· You have selected an invalid selection file.

Create a new selection file and resubmit the job.



Unable to read log file <file_name>.
The log file <file_name> could not be read because:

· The user does not have sufficient rights to the file.

Make sure that the user has Read rights to the file.

· The file is corrupt.

Restore the file from the most recent backup tape containing it.

· The Backup Server is down.

Try the operation again when the Backup Server is available.



Unable to use the log path in the Backup Server configuration file.
· The log path specified in the Backup Server configuration file does not exist or you do not have 

sufficient rights to it.

Ensure that the log path specified in the Backup Server configuration file is correct and 
that it exists (refer to the Administration Manual for a discussion of the configuration file).  

Then, ensure that you have Read and Scan rights to the directory.



Memory Errors
Insufficient memory available.
Out of Memory.



Insufficient memory available.    
Close other applications before starting this application again.

· Not enough memory is available to load the Backup Exec software.    This is usually caused by 
having too many applications active at one time. Backup Exec requires one meg of RAM, and 
requires that Windows be in enhanced mode.

Close any active Windows applications that you are not using.    If this is unsuccessful, see
your Windows manual for additional information on making more memory available for 
Windows applications.

To continue, close another application and press Retry or press Cancel to quit.

· Not enough memory is available to complete the current operation.    This is usually caused by 
having too many applications active at one time.      Backup Exec requires one meg of RAM, and 
requires that Windows be in enhanced mode.

Close any active Windows applications that you are not using and press the Retry button.   
If this is unsuccessful, see your Windows manual for additional information on making 
more memory available for your Windows applications.



Out of Memory.
· Not enough memory is available for the operation.    This is usually caused by having too many 

applications active at one time.

Close any active Windows applications that you are not using.    If this is unsuccessful, see
your Windows manual for additional information on making more memory available for 
your Windows applications.



Network Errors
Connection to device <device_name> has been lost.
Could not obtain network information.
Error # during attachment to device <device_name>.
This workstation does not have any published drives.
Unable to get a server connection list.
Unable to get connection number.
Unable to load NETWARE.DLL.
Unable to obtain the address of device <device_name> on the network.
You do not see any backup sources.



Connection to device <device_name> has been lost.
You have lost your connection to device <device_name> because:

· The Backup Server is down.

Try to run the operation again when the server is available.

· The server's network card has failed.

Make sure network cables are connected properly and that the network card is not faulty.



Could not obtain network information.
· Backup Exec could not get the network information while trying to build the list of job histories.    

The Backup Server is probably down.

Try the operation again when the Backup Server is available.



Error # during attachment to device <device_name>.
There was an error attaching to the device because:

· The device has become unavailable and could not be recognized.

Try the operation again when the device becomes available.

· The Backup Exec Agent publishing the device may be locked.

Unload the Backup Exec Agent software for the device and reload it.

· The maximum number of users may already be attached to that device.

Try the operation again when there are fewer users attached.



This workstation does not have any published drives.
· The Backup Exec Agent that you attempted to attach to does not have any published drives.

If you attempted to attach to your own Agent, load the Agent Publisher software and publish
the drives.    Otherwise, contact the custodian for the workstation running the Agent.



Unable to get a server connection list.
· Backup Exec was unable to get a server connection list to determine which of your connected 

servers were backup servers.    You have probably lost your connection to the network.

Try the operation again when the server becomes available.



Unable to get connection number.
· Backup Exec could not get the connection number to a server that you were formerly attached to. 

The server is probably down.

Try the operation again when the server is available.



Unable to load NETWARE.DLL.
· The network is not enabled for Windows or the network shell is not loaded.

Go the Windows Setup and set the network to Novell NetWare (you must be running shell 
version 3.21 or higher).    If this is already set, try setting it to None, then resetting it to 
Novell.    If the network shell is not loaded, exit Windows, load the shell, and then return to 
Windows.    Refer to your Windows documentation for assistance.



Unable to obtain the address of device <device_name> on the network.
· Backup Exec was unable to determine the internet network address of a server for remote login.

Check the NetWare bindery (3.x) or NetWare Directory Services (4.x) to see if it is 
corrupted.    For more information, refer to your NetWare documentation.



You do not see any backup sources.
· You are running an outdated version of the network shell.

Install version 3.21 or greater of the network shell.    Your IPX.COM must be 3.10 or greater.



Password Database Errors
Error accessing the password database.
Error reading the password database.
Error writing to the password database.
Unknown password database error: #.



Error accessing the password database.
· Backup Exec could not access the Password Database.

Quit and restart Backup Exec, then try the operation again.    If the problem continues, you 
will need to delete the password database file (BEWIN.PWD) and recreate it.



Error reading the password database.
· Backup Exec was unable to read the Password Database.

Quit and restart Backup Exec, then try the operation again.    If the problem continues, you 
will need to delete the password database file (BEWIN.PWD) and recreate it.



Error writing to the password database.
· Backup Exec was unable to write to the Password Database, or an error occurred that would not 

allow the file to be updated.

Quit and restart Backup Exec, then try the operation again.    If the problem continues, you 
will need to delete the password database file (BEWIN.PWD) and recreate it.



Unknown password database error: #.
· An unexpected Password Database error has occurred.    This is probably error 308, the 

<server_name> / <user_name> / <password> combination is too long.

Make sure the <server_name> / <user_name> combination is 175 characters or fewer and 
the <password> is 96 characters or fewer.



Printing Errors
There are no printers available.
Unable to start the print operation.



There are no printers available.
· Windows does not have any printers configured.

See your Windows manual for information on setting up printers.



Unable to start the print operation.
· The configured printer is off-line or unavailable.

Change configured printers or try the operation again when the printer is available.



Resource File Errors

Inconsistent resource files were found. 
· The resource file, BECRES.DLL, that Backup Exec - Windows Client is attempting to use is from 

another version of the software.

Edit your AUTOEXEC.BAT file and remove the two lines that load the agent files.    Then, 
reboot the computer and reinstall the Backup Exec - Windows Client software.



Selection File Errors
Cannot open the selection file <filename>.
Unable to open selection file.



Cannot open the selection file <filename>.
· The file may not exist or it may be corrupt.

Make sure that the file exists.    If the file is corrupt, you will need to recreate it using the 
Backup Exec - Windows Client software.



Unable to open selection file.
· The file does not exist or it may be corrupt.

Make sure that the file exists.    If the file is corrupt, you will need to recreate it using the 
Backup Exec - Windows Client software.



Backup Exec Errors
Your Backup Server connection is no longer valid due to your Backup Server going down.
Your Backup Server connection is no longer valid due to your Backup Server going down or a disconnect 
in the cabling.
Error (#) opening job queue on Backup Server <server_name>.
There was an error changing to the new Backup Server.
There was an error returning to the current Backup Server.
Unable to change to this Backup Server.
Unable to find any Backup Servers.
Unable to open Backup Server file BEMGR.CFG.
Your workstation is not attached to your configured Backup Server.
Backup Exec locks up while scanning for Network Agents at initialization or Backup Sources refresh.



Your Backup Server connection is no longer valid due to your Backup Server 
going down.

· The connection to your configured Backup Server has been lost.    Your Backup Server is 
probably down.

Change to another Backup Server or exit the Backup Exec - Windows Client and restart it 
when the server is up.



Your Backup Server connection is no longer valid due to your Backup Server 
going down or a disconnect in the cabling.
The connection to your configured Backup Server has been lost because:

· The server has gone down.

Change to another Backup Server or exit the Backup Exec - Windows Client and restart it 
when the server is up.

· The server's network card has failed.

Make sure that the network cables are connected properly and that the network card is not
faulty.



Error (#) opening job queue on Backup Server <server_name>.
The job queue could not be opened on the Backup Server because:

· The job queue has been removed from the server

Load the Job Manager on the Backup Server to recreate the job queue and try the operation
again.

· The network administrator has disabled user jobs from being submitted to the queue.

Try the operation again when the queue is available.



There was an error changing to the new Backup Server.    
You attempted to change to a Backup Server:

· That did not have a configuration file.

Go to Job Manager's main menu on the Backup Server you are attempting to access.    
Select the Options menu item and then select Save Options.    This will write the 
configuration file.

· That is down.

Try the operation again when the server is up.

· From which the job queue has been removed.

Load the Job Manager software on the Backup Server.    This will create the queue.    Retry 
the operation once the queue has been created.

· To which you do not have sufficient rights to submit a job.

Make sure that you have Write rights to the Job Queue on the Backup Server.



There was an error returning to the current Backup Server.
You encountered an error in trying to return to your previous Backup Server after a failed attempt to 
Change Backup Server because:

· The configuration file has been deleted.

Go to Job Manager's main menu on the Backup Server you are attempting to access.    
Select the Options menu item and then select Save Options.    This will write the 
configuration file.

· The server is down.

Try the operation again when the server is up.

· The Backup Server's job queue has been removed.

Load the Job Manager software on the Backup Server.    This will create the queue.    Retry 
the operation once the queue has been created.

· You no longer have sufficient rights to submit a job to the queue.

Make sure that you have Write rights to the Job Queue on the Backup Server.



Unable to change to this Backup Server.
You attempted to change to a Backup Server:

· That did not have a configuration file.

Go to Job Manager's main menu on the Backup Server you are attempting to access.    
Select the Options menu item and then select Save Options.    This will write the 
configuration file.

· That is down.

Try the operation again when the server is up.

· From which the job queue has been removed.

Load the Job Manager software on the Backup Server.    This will create the queue.    Retry 
the operation once the queue has been created.

· To which you do not have sufficient rights to submit a job.

Make sure that you have Write rights to the Job Queue on the Backup Server.



Unable to find any Backup Servers.    
Your functionality will be limited until a Backup Server can be found.

· You are not attached to any Backup Servers.

Login or attach to a server running the Job Manager.



Unable to open Backup Server file BEMGR.CFG.    
You may have insufficient rights to this directory.

The Backup Server's configuration file could not be opened because:

· The configuration file does not exist.

Go to Job Manager's main menu on the Backup Server you attempted to access.    Select the
Options menu item and then select Save Options.    This will write the configuration file.

· You have insufficient rights to the SYS:\BKUPEXEC directory.

Make sure that you have Read rights to the BKUPEXEC directory.



Your workstation is not attached to your configured Backup Server.
· You are not connected to the Backup Server that is listed in your configuration file as your default 

Backup Server.    This is usually the last Backup Server that you were attached to in the Backup 
Exec Windows Client.

Select another Backup Server to submit jobs to, or attach to your configured Backup 
Server.



Backup Exec locks up while scanning for Network Agents at initialization or 
Backup Sources refresh.

· The server whose name is shown in the Scanning for Network Agents message box is down.    
There is no way to recover from this condition.

Reboot your system and try the operation again.    If this problem persists, contact 
Technical Support.



Glossary of Terms
Active
Admin
Administrator
Agent
Append
Archive bit
Backup
Backup Exec Agent
Backup Horizon
Backup Job
Backup Log
Backup Server
Backup Set
Backup Sources Window
Backup Strategy
Backup Types
Baseline Backup
Branches
Catalog 
Check 
Check Box
Client
Collapse
Confirmation Dialog
Continual Job
Copy Backup
Current Backup Server
Differential Backup
Directory Tree Window
Expand
File Grooming
Full Backup
Fully Cataloged Backup Sets
Grayed
Highlight
Include Subdirectories



Incremental Backup
Index
Job
Job History
Job Manager
Job Queue
Job Schedule
Label Bar
Multiple Selection List Box
NetWare Agent
Normal Backup
Object
Once-Only Job
Overwrite
Partially Cataloged Backup Sets
Password Database
Password Database Usage
Permanent Backup
Prepared Tape
Publish
Published Network Agent
Restore
Restore Sources Window
Scroll Bar
Search
Selection File 
Selections
Service
SMS
SMDR Include (SMDRINCL.DAT)
Split Bar
Status Bar
Tape Family
Tape ID
Tape Rotation Database
Tape Rotation Tasks
Tapes Window



Selection Bar
TSA
Uncheck 
Volume
Wildcards



Active
Window - The window currently selected is active.    If multiple windows are open, the title bar for the 
active window is usually a different color or intensity from other window title bars.

File(s) - A dotted rectangle (selection cursor) around the highlighted icon and text indicates the active 
item.



Admin
Administrator.    Admin is displayed in the status bar when you are logged into the current backup server 
with administrator (supervisor) privileges.



Administrator
You are an Administrator if you have supervisor privileges on your current backup server.    Certain 
Backup Exec functions can only be performed by Administrators, and are not presented to other users.    
Within Backup Exec Help messages, such functions are identified by the phrase Administrator only.



Agent
A module that runs on workstations and servers in the network, enabling remote workstation access.    An 
agent can be either a NetWare Target Service Agent (TSA) supplied by Novell, or a Backup Exec Agent.



Append
When performing a Backup operation, choosing Append will add Backup Sets after the last Backup Set 
on the tape.



Archive bit
A file can only be in two states: either it has been backed up or it is a new or modified file.    The archive 
bit indicates if the file is new/modified since the last Normal or Incremental backup or if it has been 
backed up.



Backup
A process where selected directories and files contained on one or more disk drives are copied and 
stored on a reliable form of media (i.e., tape).



Backup Exec Agent
A Backup Exec Agent is a component supplied with Backup Exec that allows remote workstation access.  
In the application, you see these agents under the Backup Exec Agents branch in the Backup and 
Restore Sources windows.



Backup Horizon
The amount of time in a schedule from which you can restore a backup.    For example, the default tape 
rotation weekly backup strategy allows you to restore data up to three weeks preceding your last backup.



Backup Job
File selections made from one or more devices that are submitted by an administrator or user to be 
backed up by the Job Manager.



Backup Log
A record of all of your backups.    Backup Exec's Job History functions as your on-line backup log.



Backup Server
The server running the Job Manager and housing the tape drive.    The server to which you are currently 
attached is your current backup server.



Backup Set
When a backup job is run, the data selected for the backup is placed together on tape in a "backup set".    
For example, when you do a full backup of your workstation, all of the files and directories are placed on 
tape as a backup set.    Backup sets contain files from one device only (i.e., a server volume or client 
workstation drive).    Files selected from multiple devices create multiple backup sets.



Backup Sources Window
Backup Exec displays this window when you click on the "Backup" icon.    The window displays all 
NetWare Agents and Backup Exec Agents that are available.    To select one or more Agents for backup, 
move the cursor to the check box beside the agent name.    The cursor changes to a pen.    Click on the 
check box to select the agent.    If the checkbox is empty, the item is not selected.    If the checkbox is 
checked with a black mark, the item is fully selected.    If the checkbox is marked with a gray mark, then it 
is partially selected.    For example, if you select a single file within a directory, a gray mark will appear in 
the box.

You can also double-click on the agent name or use the Expand command to view the drives available for
the agent.    Double-click on the drive name to display its directories.    Double-click on the directory name 
to display its files.    You can use the check boxes to select specific drives, directories, and files for 
backup.    You can save these selections in a selection file for future use, through the Save Selections 
function.

Once your selections are made, choose Schedule Backup from the Jobs menu to place your backup on 
the job queue.

If a new agent has been published since the application was started, it will not show up in the Backup 
Sources Window until the window is refreshed (using the F5 function key).    If the NetWare Agent you are 
looking for still does not appear in the window, it is possible that the agent is not in the SMDRINCL.DAT 
file.



Backup Strategy
The procedures you implement for backing up your network.    A good backup strategy allows minimal 
time to get a device up and running in the event of a disaster.



Backup Types
When a file is backed up, Backup Exec checks the file's status to see if it has been backed up.      When 
you run a backup, you can specify whether you want Backup Exec to see the file as having been backed 
up.    This is necessary when you incorporate a backup strategy.    There are four backup types:

Normal (default)- backs up all selected files and changes the file status to "backed up".

Incremental - only backs up selected files that were modified or created since the last Normal backup.    
Selecting Incremental will also change the files' status to "backed up".

Differential - only backs up selected files that were modified or created since the last    Normal backup.    
Selecting Differential does not affect a file's backup status.

Copy - backs up all selected files, but does not change their backup status.



Baseline Backup
The initial full backup that takes place the day a tape rotation job is set up.



Branches
A segment of the Directory Tree, representing a directory and any subdirectories it contains.



Catalog 
A catalog keeps track of the contents of tapes created during a Backup or File Grooming operation.    The 
information in the catalog is the basis for the information in the Restore Sources window.    You can only 
restore information from fully cataloged tapes.    You can search for files in a catalog through the Catalog 
Search function.    If you are an administrator, the search will show all file catalogs that meet the criteria 
you specify.    If you are not an administrator, the search will show only the file catalogs that you have 
backed up.



Check 
Backup Exec uses a check in the check box to indicate the type of selection.

A check mark in a white check box indicates full selection.

A check mark in a gray check box indicates partial selection.



Check Box
A square box on the left side of a disk, directory, file, server, volume, tape, or backup set icon, displayed 
in the directory tree window.    When you place the cursor on a check box, the cursor becomes a pen.    
Click the mouse to check or uncheck the box and select or deselect an item.



Client
A client is a front-end product that interfaces with the Backup Server and Backup Exec Agents.    You are 
currently running the Windows or OS/2 version of the Backup Exec client.    The client allows you to 
submit jobs, check the status of your jobs, review job results, and perform other administrative functions.



Collapse
To hide additional directory levels below a selected directory in the Directory Tree.



Confirmation Dialog
If you perform an action that can be destructive to data (for example, deleting a job), Backup Exec gives 
you a chance to change your mind before acting on your request.    A confirmation dialog box asks you to 
verify that you want to carry out the action.    Click on Yes if you want to proceed, or No if you decide not 
to proceed.



Continual Job
A job that is scheduled to run on a recurring basis.    With Backup Exec, you can schedule jobs to occur at
a specified daily, weekly, or monthly interval.



Copy Backup
Backs up all selected files, but does not affect the file's backup status (does not reset the archive bit).



Current Backup Server
The Current Backup Server is the Backup Server with which you are working right now.    If you submit a 
backup job, the tape attached to this server will become the destination for the job.    You can choose 
another Backup Server through the Change Backup Server function.



Differential Backup
Backup that includes only files changed or created since the last Normal backup.    Files backed up 
differentially do not reflect that they have been backed up.



Directory Tree Window
A graphic display of a disk's or tape's directory structure.    The directories on the disk or tape are shown 
as a branching structure.    Directories are shown as branches extending from the top-level directory 
known as the root directory.



Expand
To show hidden directory levels in the Directory Tree.    With Backup Exec, you can expand a single 
directory level, one branch of the Directory Tree, or all branches at once.



File Grooming
A process where selected directories and files contained on one or more disk drives are copied to tape, 
automatically verified, and if successfully verified, deleted from the disk drive(s).



Full Backup
Backup strategy that includes all files on a device



Fully Cataloged Backup Sets
A fully cataloged backup set is the norm for Backup Exec.    Backup sets are always fully cataloged unless
a job is aborted.    If this happens, you will have a partially cataloged backup set.



Grayed
A menu command that is gray in color (shaded) instead of the normal dark color indicates that the 
command is not available for selection.



Highlight
Highlighted text identifies an item, such as a disk, directory, file, server, volume, tape, or job, that is 
selected.    Highlighted text appears with a colored background; e.g., text may appear as white on a black 
background or, on color monitors, as black with a colored background.



Include Subdirectories
You have the option of displaying subdirectories contained within directories in the Directory Tree.    To do 
so, choose Include Subdirectories from the Select Menu.    A check appears beside the Include 
Subdirectories command.    To hide subdirectories, choose Include Subdirectories from the Select Menu 
and ensure that a check does not appear beside the command.    You can also display subdirectories by 
double clicking on the icon representing the directory you want to expand.



Incremental Backup
Backup that includes only files changed or created since the last Normal or Incremental backup. Files 
backed up Incrementally reflect that they have been backed up.



Index
The Index contains a list of all Help topics available for Backup Exec. For information on how to use Help,
press <F1> or choose Using Help from the Help menu.



Job
A job is a task that has been scheduled for processing by the Backup Server.    For example, if you make 
selections and submit a Backup based on those selections, you have created a job.



Job History
A job history is created when a job runs.    It contains the output from the Job Manager that resulted from 
the job being run.    You can review the job history to find out if your job was completed successfully.



Job Manager
The Job Manager is Backup Exec's server-based module.    The Job Manager is comprised of two 
components: the Job Server NLM, which performs the actual job processing; the Job Console NLM, 
which is the Job Server's user interface.



Job Queue
The list of jobs waiting to be processed by the Job Manager.



Job Schedule
The Job Schedule allows you to view the jobs in the queue to be run by Backup Exec. You can choose to 
view all jobs or only the jobs you have submitted.



Label Bar
The bar across the top of the Backup Resources Window, Restore Resources Window, and Tapes 
Window that provides column headings for the information in these windows.    You can display or hide the
label bar using the "View" menu.



Multiple Selection List Box
A multiple selection list box is a Windows concept.    In a multiple selection list box, you can select more 
than one element, then apply a procedure (such as Delete or Check) to all of the selected elements at 
once.    You can select multiple items by using the mouse to click and drag (highlighting all selected 
elements), or use Shift plus the cursor movement keys.



NetWare Agent
A NetWare Agent, known in Novell terms as a TSA, is a component supplied with Novell's NetWare that 
allows remote workstation access.    In the application, you see these agents under the NetWare Agents 
branch in the Backup Sources and Restore Sources.



Normal Backup
Backup that includes all selected files on a device and changes the files' status to "backed up".



Object
An object is any type of entity contained within a network service.    These include file servers, print 
servers, user groups, or volumes.    In Backup Exec for Windows, most objects are volumes.    Objects are
always the final level of the Tree; any items contained within expanded objects are displayed in the 
Directory window.



Once-Only Job
A job that is scheduled to run one time only.    After a once-only job has processed, Backup Exec removes
it from the queue.    In order for a similar job to occur again, it must be submitted again.



Overwrite
When performing a Backup operation, choosing Overwrite will start the backup at the beginning of the 
tape and replace the data on the tape with the data being backed up.



Partially Cataloged Backup Sets
A partially cataloged backup set results from an aborted job.    You cannot select individual files from a 
partially cataloged backup set, but you can restore the entire set.    In order to fully catalog the backup set,
you must re-catalog the tape, which can only be done at the backup server.



Password Database
Backup Exec for Windows allows you to use an on-line password database to store login information.    If 
you use this database, you will be prompted for login information (password and user ID) the first time you
access a backup server that is protected by password security.    Your login information is then stored in 
the database and automatically supplied the next time you attach to the server.    Be careful; do not leave 
your workstation open to unauthorized access if the password database is in use.



Password Database Usage
The password database is a collection of passwords required for access to various devices.    Backup 
Exec for Windows makes use of this database when:

· Users are accessing devices in the Directory Tree that require a password.    Initially, users are 
prompted to enter a password and a user ID for the device.    The system adds this information to 
the password database.    After this initial access, users are no longer prompted for security 
information when accessing the device.

· Users schedule a Restore operation.    The password database is used to generate a list of 
potential target devices that appears in the Restore to Device field of the Restore submission 
dialog box.

· Users load saved selections.    If the database is used, the system does not prompt for a 
password for each device in the selections that requires a password; otherwise, it prompts for 
passwords for each device included in the selection set.    Therefore, usage of the database 
streamlines the use of selection sets.

Backup Exec enables you to protect the database itself through a password, assigned through the 
Options Menu - General option.    If your database is password protected, Backup Exec prompts you for 
the database password when you start the application.    If you enter the correct password, the password 
database is opened for use during the session.    If you enter an incorrect password, Backup Exec 
displays an error message and gives you another opportunity to enter a correct password.    You have 
three chances to enter a correct password; if all three tries are unsuccessful, Backup Exec starts with the 
password database locked.    You cannot enable the password database or work with it in any way while it
is locked.    You must restart the application using a correct database password to unlock the database.



Permanent Backup
A backup which is intended to never be overwritten.



Prepared Tape
Tape rotation jobs require specially prepared tapes.    This allows Backup Exec to automatically track the 
tapes.    Tapes are prepared in the Job Manager.



Publish
In order for Backup Exec to recognize a workstation volume, the volume must be published through the 
Backup Exec Agent.    Publishing a volume "advertises" the existence of that volume to Backup Exec 
Clients.    Until the volume is published, clients cannot access it.    To publish a volume, use the Agent 
Publisher program furnished with Backup Exec.



Published Network Agent
Workstations that are available to be backed up.    An agent may be either a NetWare agent or a Backup 
Exec agent.



Restore
An operation that retrieves a file from tape to a device.



Restore Sources Window
Backup Exec displays this window when you click on the "Restore" icon.    The window displays all 
NetWare Agents and Backup Exec Agents that have been backed up by the current backup server.    Only
cataloged backups are displayed.    Use the left-hand side of the window to select the volume to which 
you want to restore information.    Click on a volume name to see the backup sets associated with that 
volume.    You can then decide which backup sets you wish to restore and mark the check box beside 
each set accordingly.

Once your selections are made, choose Schedule Restore from the Jobs menu to place your restore job 
on the job queue.



Scroll Bar
A bar that appears at the right and/or bottom edge of a window whose contents are not completely visible.
Each scroll bar contains two scroll arrows and a scroll box, that allows you to scroll within the window.



Search
A feature included with Backup Exec that allows you to quickly find files you wish to restore.



Selection File 
A selection file is a "template" of    device, drive, and file selections that you save for re-use in future 
backup operations.    



Selections
When you set up a job, you identify the devices, drives, directories, and files that you want to back up or 
restore.    These are your selections.    You can save these selections in a selection file and reuse them as 
needed.    Selection files are also referred to as scripts.



Service
A service is a grouping of objects within a NetWare agent.



SMS
Storage Management Services (SMS) is an interface developed by Novell which allows backup and 
restore software to "see" objects in a network, such as volumes, workstations, databases, etc.    In the 
application, you see these SMS objects under the NetWare Agents branch in the Backup and Restore 
Sources windows.



SMDR Include (SMDRINCL.DAT)
If you have a large number of NetWare servers on your network, it may be inconvenient to have all of the 
NetWare servers in your backup sources list.    You can use the SMDRINCL.DAT file to limit the number of
servers that are scanned and displayed by the Windows/OS/2 Client.    The SMDRINCL.DAT file is an 
ASCII text file that you can edit with a text editor.    This file is located in the \BKUPEXEC directory

If a SMDRINCL.DAT file exists on the backup server, it will override the SMDRINCL.DAT on the 
workstation.



Split Bar
When you are in a directory tree window, the window is split into two parts.    If you select the Split 
command from the View menu, a split bar appears between the two parts.    Use your cursor to move the 
split bar and adjust the size of each window portion as needed.



Status Bar
The bar at the bottom of the Client window identifying the current status of Backup Exec.    The status bar 
also identifies your current backup server and user name.    If you are not attached to a backup server, the
message "No Backup Server" is displayed and the user name is blank.    If you have administrator 
(supervisor) privileges, the user name field displays "Admin"; if you are not an administrator, the user 
name field shows your Novell login name.    You can display or hide the status bar using the "View" menu.



Tape Family
When a backup spans a tape, the tapes that contain the backup are referred to as a "tape family".



Tape ID
A tape ID number is assigned to each tape when it is prepared.    The ID number allows Backup Exec to 
identify each tape rotation tape.



Tape Rotation Database
The tape rotation database is a group of files that contain information for the tape rotation jobs that you 
have created.



Tape Rotation Tasks
Tape rotation tasks are functions that you need to perform for tape rotation jobs.    The Tape Rotation Task
window in the client software provides a listing of these functions for you.



Tapes Window
This window is displayed when you click on the Tapes icon.    It displays the tapes that are currently 
available for restoration.    Double click on a tape name to display the backup sets contained on that tape. 
This window is a helpful reference in performing catalog maintenance.

Note: The tapes window displays the same information as the Restore Sources window, it just displays 
the information by tapes instead of by devices.    File selections cannot be made in the tapes window.    To 
make restore file selections, use the Restore Sources window.



Selection Bar
The bar at the top of the Client window containing buttons representing Backup Exec functions.    To 
quickly access one of these functions, click on the appropriate icon with the mouse.    You can display or 
hide the tool bar using the View menu.    For more information about these buttons, refer to the Bitmaps 
and Icons help text.



TSA
A NetWare Target Service Agent.    



Uncheck 
If you change your mind about a selection, you can uncheck it.    This action removes the check mark from
the check box and deselects the item.



Volume
A volume is a defined amount of hard disk storage space.    It is considered to be the highest level of the 
Directory Tree structure, similar in concept to the root directory in DOS.    Volumes can be divided into 
directories, which can be subdivided into subdirectories.



Wildcards
Backup Exec for Windows supports the use of wildcard characters to include groups of files in an 
operation.    Use a question mark (?) to identify any single character, and an asterisk (*) to identify any 
number of any character.

EXAMPLES:

*.DOC includes all files with an extension of .DOC.

?????.B* includes all files whose extensions begin with B and whose names contain precisely five 
characters.    File 12345.B2 would be included, but 1234.BBB or 12.B would not, because their names do 
not contain exactly five characters.

NOTE:  If you are searching for a file using the Catalog Search function, it is recommended that you try to
specify the first character or two of the file name.    This will speed the search process.




